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Revox Restoration

Look around, and you may find an
analogue tape recorder bargain. Martin
Pipe gives us a low-down on the classic
Revox A7T7,

PC Securlty
In this last part, Mike Bedford

Projects
22

High Fidelity Class AB1
Valve Power Amplifier

Mike Holmes describes a design
based on the famous Williamson valve

27
60

75

amp using KT66 Output Valves.

Ultrasonic Detector
Gavin Cheeseman describes a low-
cost, wideband ultrasonic detector.

Wind Speed, Direction and
Temperature Indicator - Mark Il
in part 2, Dr. Mike Roberts concludes
the construction of his upgrade to the
excellent Maplin Weather Station project.

Measuring Small
Temperature Changes

Dr. Pei An describes a computer-based
temperature measurement system.

Features

7

The Integer House
Paul Freeman-Sear reports on an eco-
friendly dwelling for the future built at

69

discusses the need for backup.

Cavorting with Chaos
Douglas Clarkson concludes his ook
at ‘Chaos’.

Future Reusable Space
Vehicles and the Iinternational
Space Station

In this second part Dr. Chris Lavers
continues his look at the latest
developments in space launchers,
and describes the proposed
International space Station.

Using Voltage Reference and
Temperature Sensor ICs

In this second part, Ray Marston shows
how to use various popular 'current
source' and 'temperature sensor' ICs.

Easy Web Page Creation

In part 2 Mike Holmes discusses
enhanced layout design, '‘Anchors' and
index pages.
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Establishment at Watford, primarily to see the eco-friendly

house that featured in the BBC TV series Dreamhouse.
Although the house appears to be an experimental prototype, it
does show us what is possible, and the energy savings that can
be made. You can read more about the Integer House in my
article on page 7.

For those of our readers who remember reel-to-reel audio tape
recorders, Martin Pipe has written an interesting article on restoring
an old Revox tape deck. It is true to say that Revox produced the
best semi-professional tape decks, and were designed to have a
very long and reliable life. Such tape decks are still available and
Martin gives suggestions as to where to find them.

On-line ordering, via the Internet, is set for rapid growth, and
we at Maplin have joined the club. You can now order items
from the current catalogue over the Internet. The one big
advantage of the Maplin site is that you get confirmation that
your selection is in stock.

If you prefer to shop in person then the latest Maplin store
has now opened in Dublin, at Units 1-4, The Smyths Building,
Jervis Street DUBLIN 1.

Congratulations..

Go to Nyuk Shiong Ho of Plymouth, Devon and Stephen
Stopford of London, who’s names were picked out of our hat
in our July issue 139 draw, and will be receiving a portable
soldering iron from Antex. Well done!

I recently had the good fortune to visit the Building Research
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VEWS,
REPORT

Motorola Handset Wins Gold for
Industrial Ilesign Excellence

Motorola has been honoured with a gold award in the Business and
Industrial Products category of the 1999 Industrial Design Excellence
Awards (IDEA) for the i1000 integrated digital handset.

The Motorola i1000 handset combines the capabilities of a digital
cellular telephone, two-way radio, text messaging and data
capabilities into a single, palm-size handset.

For further details, check: <www.motorola.com>.

Contact: Motorola, Tel: (01293) 404343.




MIT Researchers
Help Create Map
Of Mars Terrain

Researchers have known for
some time that Mars has a deep
dent in its southern hemisphere.
But until recent measurements
vielded a highly accurate, global
map of the red planet's

topography, they didn't know that |

the Hellas basin could swallow
Mount Everest, or that the
asteroid that caused the crater
hurtlect debris as far as 2,500
miles across the planet's surface.

"Probably the most unexpected :

finding was how much the Hellas
impact basin dominates the
topography of the southern
hemisphere,” said Maria Zuber,
Griswold Professor of Planetary
Sciences at the Massachusetts
Institute of Technology. Another
major finding is the planet's
dramatic slope from its south to
north pole. This would have

significantly affected water transport
¢ evolution of the planet," Zuber
: said. "From the shape of the

¢ surface and information on

¢ gravity, magnetics and surface

¢ composition, we can model the
¢ internal structure and the
global grid of Mars based on data

and cycles on the planet, she
said, leading to ponding of water
in certain places.

Zuber and three other MIT
researchers are part of a team of
20 scientists who created a

from the Mars Orbiter Laser
Altimeter (MOLA), an
instrument on the Mars Global
Survevor spacecraft. Their work,
published in the May 28 issue of
the journal Science, is expected
to lead to new insights about
how Mars evolved over the past
4 hillion vears.

The map is expected to give
scientists the basis for many

and definition of the red planet.
"The most significant aspect of
the data is that it is going to

allow us to reconstruct the

planet's thermal evolution.

¢ These models bear closely on
¢ the history of climate and water.

"It is going to take some work,

¢ but the potential is there to

¢ construct and evaluate models of
¢ the planet as a global system.

¢ This is an extraordinary

¢ opportunity to study how the

¢ different parts of a planet

¢ influence and are affected by

. other parts,” she said.

years' worth of further exploration :
i check: <web.mit.edu>.

For further details,

Contact: Stanford University,

{Tel: +1 617 253 1000.

- Small is Big for
Digital Canglera
The Fujifilm MX-2700 Digijtal is reckoned to be
the world's smallest 2.3 million pixel digjtal
camera. The MX-2700 features a 35-mm
equivalent lens with macro capability and carries
an impressive 1,800 x 1,200 resolution, boasting
one of the highest pixel counts available.
Depending on the image compression
selected: fine, normal, or basic, the MX-2700
can record 8, 17 and up to 35 images
respectively on bundled 8MB SmartMedia card
in 1,800 x 1,200 mode, and similarly 47, 90,
and up to 142 images in 640 x 480 mode.
For further details,

check: <www. fujifilm.co.uk>.
Contact: Fujifilm, Tel: (0171) 586 5900.

Terminal Tantrums

Office workers are getting
increasingly frustrated with their
computers, according to a Compag-
sponsored survey from research firm
MORI, and the frustration is leading
to high rates of computer abuse.
Among the typical forms of abuse
are swearing-at PCs, physically hitting
or kicking the computer, bullying the
[T department, absenteeism, and
bad-mouthing at the employer.
Workers said computer or
software problems cause more than
one interruption in work each day,
and many said it often takes more
than an hour to fix the problem.
For further details,
check: <www.compaq.com>.
Contact: Compadq,
Tel: (0845) 2704222.

intel Moves To
Bigger Chips

Intel is refurbishing its production
facilities to accommodate a change
to 300mm diameter silicon
wafers - a move that promises to
double production volumes while
cutting manufacturing costs by a
third. Currently, Intel and other
chip makers use 200mm wafers
as the base material for
integrated circuits. The first
facility to use the 300mm
technology will be a new £700
million plant in Oregon.
For further details,
check: <www.intel.com>.
Contact: Intel,
Tel: (01793) 403000.

3Com Forms
Wireless Company

3Com and Aether Technologies
have formed a partnership to create
a new company called OpenSky
that will focus on developing
wireless technology to support
corporate e-mail, Web use, and
company-wide information sharing
via a wide variety of mobile devices,
such as 3Com's own Palm Pilot
handheld personal digjtal assistants.
For further details,
check: <www.3com. com>.
Contact: 3Com,
Tel: (0118) 927 8200.

Nokia Embraces a
Plan to Unify Third
Generation Mobile

Nokia has announced its support
for a framework that would bring
a harmonised, global standard
for third generation’
communications technology
worldwide. The proposals, put
forward to the International
Telecommunications Union TG8/1
meeting in Beijing, China, would
provide a single wideband CDVA
standard, harmonising both
WCDMA and ¢cdma2000 systems.
For further details,
check: <www.nokia.com>.
Contact: Nokia,
Tel: (01480) 434444,
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Be and Echo Break
Through Audio
Performance Barrier

Be has expanded its audio driver
capabilities through a development
partnership with audio technology
leader Echo. Digital media
producers using Echo's Layla,
Darla, and Gina multi-channel
audio peripherals and BeQS will
experience unprecedented levels
of performance with their multi-
tracking audio software.

Each product offers multiple
20-bit analogue input and
output; Layla and Gina give
users additional flexibility with
digital input and output. Echo
will bring 24-bit, 96k audio
capabilities to their products in
Autumn 1999.

For further details,
check: <www.beos.com>,

Contact: Be, Tel: +33 1 55 91 77 30.

Tweeter Achieves

Iimproved
Performance

Boston Acoustics has received a
patent for its new high power
tweeter. The high power tweeter
design utilises a sub-compact
magnet assembly built around a
miniature high-energy neodymium
magnet, instead of a conventional
bulky ferrous magnet. This improves
speaker performance by allowing
the tweeter to be placed physically
right next to the woofer, resulting in
superior sound quality.

For further details, check:
<www.bostonacoustics.com>.

Contact: Boston Acoustics,
Tel: +1 978 538 5000.

WordPerfect Office
2000 Available

After nearly two years in
development, Corel's flagship
package WordPerfect Office 2000
is available to consumers who wiil
have the opportunity to experience
the future of office suite productivity.
With this latest release Corel has
concentrated on delivering greater
performance, increased
compatibility, and value for money.
For further details,
check: <www,corel.com>.
Contact: Corel,
Tel: (0800) 973189.

No Phone Jack?
No Problem

3Com has introduced the 3Com
Megahertz 56k global GSM & cellular
modem PC Card. It is a modem that
gives laptop users fast and reliable
access to corporate networks and
the Intemet - whether connecting via
standard phone lines or the most
popular celiular and GSM phones. It
also features 3Comss durable XJACK
connector for easy, dependable phone
connections without additional cables.
For further details,
check: <www.3com.com>.
Contact: 3Com,
Tel: (0118) 927 8200.

atin Shows Ultra
First Silicon

Scott McNealy, chairman and CEO of Sun
Microsystems has shown the first working sample
of Sun's new UltraSPARC 1II computer processor.
Featuring 6+-bit next generation architecture,
the high performance UltraSPARC 111 family of
processors will have a clock frequency

— 4

i beginning at 600MHz to be utilised in svstems

with up to 1000 processors working together in
the same server. Volume production is expected
by the end of 1999.
For further details, check: <www.sun.co.uk>.
Contact: Sun, Tel: (01276) 451440.

Java to Drive Palm Pilots

Sun and 3Com have cut a deal that will allow
3Com to use Sun's Java operating system on
3Com's Palm Pilot handheld computers. The
alliance will help both companies ward off
competition from handheld devices that are based
on Microsoft's Windows CE operating system.

For further details, check: <www.3com.com>.

Contact: 3Com, Tel: (0118) 927 8200.

'HP Unveils New
Line of PCs

Hewlett-Packard has announced three HP Pavilion
¢ PCs that feature a new design; broadband
capabilities; expanded customer service and

¢ support; and, on HP Pavilion 8000 PC serics, a new
one-touch multimedia kevboard.

The HP Pavilion 8570¢ PC has a smokv

translucent panel incorporated into the front of its
. tower, The new multimedia kevboard is designed
to work directly with ISP’s services such as AOL

¢ and Yahoo.

For further details. check: <www.hp.com>.
Contact: HE, Tel: (0990) 474747,
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Lucent Technologies Bell Labs
researchers Jinendra Ranka and
Robert Windeler have invented a
novel optical fibre that converts
a single colour of light into all

yellow, green, blue and violet -

as it travels through the fibre.
Our photo shows two of the

fibres in lab experiments,

i generating light that is very tightly

the colours of the rainbow - from : confined to a narmow beam in each | Contact: Lucent,

invisible infra-red to red, orange, fibre's core. It is surrounded by a © Tel: (01252) 391600.

brain of Sand
Oscillator

The tiny device shown magnified
here is a fully functioning oscillator
used to study the effect of
magnetic fields on materials. The
oscillator, creared ar Lucent
Technologies' Bell Labs, measures
about a hair’s thickness in length
and half thar distance in width - or
roughly 0.004in. by 0.002in.

The oscillator, which vibrates
up to 30.000 times per second.
belongs to a new class of devices
known as micro-electro
mechanical systems (MEMIS),
which are tinv machines smaller

. glass microstructure with air

: holes in it that cause unusual
- dispersion and low loss.

i For further details, check:

. <www.lucent.com>.

T . than a grain of sand. Bell Labs is
- . developing MEMS devices as
. i oprical switches for communications

networks and components for

. wireless handsets.

~ © For further details

5 ¢ check: <www.lucent.com>.
Contact: Lucent,

Tel: (01252) 391600.

Will Wireless Win?

A new report entitled 'Will Wireless Win? Prospects
for a Wire-Free Future' has been published by
telecoms consultancy Analysys.

The report analvses the strengths and weaknesses
of wireless technologies, such as cellular, satellite,
Bluetooth and DECT, in three kev markets voice
services over public networks: data services over
public networks; and private networks.

It also looks at the potential for wireless services

¢ in business and residential markets.
"The ability of wireless, and in particular cellular
¢ operators, to substitute wired telecoms services
o will be an important driver in maintaining high
¢ growth rates,” savs report co-author. David Wilkins.
¢ "Success will depend not onlv on their ability o
i compete with wired operators on price, quality
¢ and coverage but also on the range of Internet
i services that they can offer.”
¢ For further details, check:
: <www.analysys.com/publish>.
Contact: Analysys, Tel: (01223) 341300.

MPEG2 Rules the
Set-top Box

MPEG2, a digital video
compression technology that
shaves transmission bandwidth in
TV set-top boxes, satellite set-top
boxes, DVD players, camcorders,
and PCs, is set to grow at more
than 50% annually, says a new
report by Insight Research.
Global sales of devices that
utilise MPEG2 encoders and
decoders will reach £14 billion
this year and top £75 billion in
2003. According to Insight's
report ‘The Market for MPEG2
and Video Services’, the
convergence of communications,
information, and entertainment
is driving the need for MPEG2.
For further details,
check: <www.ircc.com>.
Contact: Insight Research,
Tel: +1 403 265 8700.

Industry Leaders
Promote Wireless IP

Nine global leaders in wireless
communications have announced
the formation of a new focus group
to promote an Internet Protocol
(IP)-based wireless system for third
generation mobile communications
technology.

The group, called 3G.IR consists of
BT, AT&T. Rogers Cantel, Ericsson,
Lucent Technologjes, Nokia, Nortel
Networks, Telenor AS, and Telecom
Italia Mobile.

Under this initiative, the nine
companies will support the
development of next-generation
wireless services such as enhanced
voice, high-speed data and Intemet
access, imaging and video
conferencing on an all IP-based
network architecture.

For further details,
check: <www.nokia.com>,

Contact: Nokia,

1 (01480) 434444

intel, HP Reveal

1A-64 Instruction
Set Architecture

Intel and Hewlett-Packard Company
has published the details of the
IA-64 Instruction Set Architecture
(ISA). This disclosure enables
software developers to accelerate
the development of the next
generation of server and workstation
applications based on forthcoming
IA-64 processors, beginning with
the Intel Merced in 2000.

The 1A-64 architecture represents
the most significant advancement
in microprocessor architecture
since the introduction of the Intel
386 processor in 1985. Published
on the Intel and HP Web sites, the
IA-64 Application Instruction Set
Architecture Guide (AIG) details
the application instruction set,
architecture features and
programming model for 1A-64
processors.

For further details,
check: <www.intel.com>,

Contact: Intel,

Tel: (01793) 403000.
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Iridium Slashes
Prices

Indium, the wireless company that
created the first global satellite
phone network, is cutting prices by
as much as 65%. Handsets now
priced at £1,400 will be reduced to
£600 or lessy and the cost of
international calls will be reduced
from £2.40 to £1.80 a minute.

The company was developed in the
late 1980s, before the development
of cheaper cellular phones that are
now quite common. Plagued by
technical, financial, and management
problems, the company has signed
around 10,000 customers, just 10%
of its intended target.

For further details, check:
<www. iridium.com>.

Contact: Orange (UK Iridium

Microchip Has 1K
Serial EEPROM

Microchip has squeezed a 1K
serial EEPROM array into a
5-lead SOT-23 package, creating
what is claimed to be the
smallest 1K serial EEPROM in a
standard package.

With its substantial space-
saving advantages, the 24LC0O1B
is targeted for applications where
reduced board size and memory
are required, including home and
automotive remote-keyless-entry
(RKE) systems; rechargeable
batteries and rechargers; user
presets in TVs, radios, VCRs, and
fax machines; and redial number
lists on telephones.

For further details,
check: <www.microchip.com>.

Contact: Microchip,

Tel: (0118) 9215869.

Motherboard Packs
Performance,

Multimedia and
Protection

Intel has announced the Intel CA810
motherboard, which is home to a
Intel Celeron processor and features
3D graphics and on-board audio.

The new motherboard incorporates
the recently announced Intel 810
chipset, which integrates Intel 3D
graphics with Direct AGP to offer
vivid 2D and 3D effects and images.

Combining the 810 chipset with
the on-board Creative Labs
SoundBlaster PCl audio subsystem,
the CA810 motherboard offers a
dependable, multimedia feature-
rich PC solution for value-minded
manufacturers and customers.,

In addition, the CA810 supports
Intef's Suspend To RAM technology,
which enables PCs to enter a power-
saving ‘sleep state’ during idle periods,
then quickly ‘wake up’ on command
without the time-consuming
shutdown/restart/reboot process.

For further details,
check: <www.intel.com>.

Contact: Intel, Tel: (01793) 403000.

Entertainment Robot

Sony has announced the availability of its four-legged entertainment
robot called AIBO, an autonomous robot that acts both in response to
external stimuli and according to its own judgement. ‘AIBO’ pre-
announced last year can express various emotions, grow through
learning, and communicate with human beings.

Not only is ‘AIBO’ capable of four-legged locomotion by virtue of

the 3° of-freedom in each of its

legs, but it can also perform other

complex movements using its mouth, tail, and head, which have 2l
2°, and 3° of freedom, respectively.

AIBO’” incorporates various sensors and autonomous programs that enable it to behave like a lving
creature, reacting to extemal stimuli and act on its own judgement. AIBO's’ capacity for learning and growth
is based on state-of-the-art artificial intelligence technology that shapes the robot's behaviour and response
as a result of repeated communication with the user and interaction with the extemal environment.

The robotic dog which is available in limited quantities costs a coot £1,500 and can be purchased

from the Sony AIBO Web site.

Sony Launches Four-Legged ’

-

For further details, check: <www.world.sony.com/robot>. Contact: Sony, Tel: (0990) 111 999.
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Low Cost OS P

Be and iDOT.com, the first PC

company built for the Web, have :

announced the first in a series
of personal computers with
BeOS pre-installed.

The first of iDOT.com's BeOS

based PCs will be priced at under

&300, including a Cvrix MII 333
processor, floppy drive, 32MB of

: RAM, a 3.2 gigabvte hard drive,
i 24X CD-ROM. kevboard and
¢ mouse. Monitors are available for

¢ and &80 for a 17in. monitor.
iDOT.com also announced

plans to create a BeOS

i storefront on the iDOT.com

i Web site, where customers will

C Launched

i be able to purchase software
¢ and other add-ons designed
i specifically for BeOS in addition
i around &70 for a 15-inch monitor

to BeOS-equipped PCs. The

¢ storefront is set to launch at the
¢ end of the summer.

For further details,

¢ check: <www.beos.com>.

Contact: Be, Tel: +33 13591 77 30.

Psion Has First Java-Based Mobile “EtWIlI‘k Gomputer

Psion has announced the
netBook, the first mobile

network computer, incorporating

100% pure Java technology.
netBook is the first product in a
range of mobile devices aimed
at companies seeking
enterprise-wide computing
solutions. Over time, the range
will include a choice of quarter,
half and full VGA pen and

¢ keyboard driven tablet and

¢ clamshell devices.

© The products will offer easy to
¢ use, 'instant-on' portable

: computing, combined with Sun
¢ Microsystem's industry standard
¢ Java platform for enterprise

© application deployment.

© netBook features Psion's first

. implementation of colour on a full
¢ VGA high quality screen offering

pen-driven navigation and data

. input and a keyboard with

¢ standard Qwerty layout. In

¢ addition to a PC card drive, it also
: has a slot for either a compact

: flash card or disk drive for large

© data storage requirements.

For further details,

© check: <www.psion.com>,

Contact: Psion,

| Tel: (0990) 134976.
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E INTEGER HOUSE

999000600060

An Eco-friendly dwelling for the future built at the
Bmldmg Research Establishment at Watford. Paul Freeman-Sear reports.

here is nothing like the equivalent of
sz adrenaline injection when it comes

to getting things done. For whatever
reason the medium of TV has that effect on
people and projects. And so rather like a
‘Challenge Anneka’ situation, the ‘smart’
home of the future had to be built within a
series of highly co-ordinated time slots, in
order to suit the filming deadlines of a BBC
TV series called ‘Dreamhouse’

The house, on the face of it, appears to be

an experimental one, with no costs spared,
to show us how an environmentallv-friendly

home of the future might look and feel.
What's different about this house is that a
lot of the technology and materials used in
its construction combine to give the house
a ‘green’ ticket. Most of this environmental
impact comes in the energy saving that the
house provides and as a result a much
lower "greenhouse’ gas called carbon
dioxide being emitted to the atmosphere.
A prototype it mav be, but the basic
house is currently available as a kit and
several lower cost versions of the Integer
House using many elements of this first

b

design are now being implemented by Sandwell
Metropolitan Borough Council, at Sandwell,
West Bromwich, Cherwell in Wiltshire and
Harlow in Essex. Average building costs for
this new design are about 10% higher than
building conventionallv.

The Integer House was built and
completed in 12 weeks, this being about
20% quicker than traditional build. This is
because many parts were prefabricated oft
site and virtuallv no standard wet trades like
bricklaving and plastering were employed. It
contains many new non standard products
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and materials to the building trade. Associated
company involvement was high with some
150 leading names replying to the invitation.
Here was an opportunity not to be missed.
As the whole project was planned around
the effect it would have on the environment,
apart from the low use of energy in its day
to day running, sustainable materials such as
wood are used and the natural resources of
rainwater and sunshine are collected.

Unconventional or What?

The remarkable thing about this project is
that it seemed to circumnavigate the many
traditional routes normally associated with
building design and erection.

The central project is co-ordinated by
Integer Intelligent and Green Lid. This name
carries a consortium of companies whose
aim, in this case, was to create an eco-
friendly and auto responsive demonstration
house. The building contractor within that
group for the demonstration house was
Wilcon Homes. They site managed and
constructed the main component parts.

A temporary planning application was
granted for two vears by the local authority to
build on 4 loaned site at the Building Research
Establishiment at Garston, Watford, This means
that after two vears either the house is pulled
down or an extension to the application can
be applied for. No contracts were issued to
supply and build in this case and no money
changed hands at all for the complete
construction and installation. As far as is
known, no detailed drawings showing the
requirements for building regulations were
submitted to the authority, working effectively

on a ‘building notice’ with regular site
inspections by the local planning authority.

The Site

Unlike ordinary building sites where a lot of
earth is taken away from the foundations to
land fill, no spoil was taken from this site. It
was rearranged within the confines of the
garden thus saving on transport and land fill
costs. The house is built on foundations of
17 rubular steel mini piles and these are
crossed with reinforced concrete inverted ‘T’
beams. All normal services are available on
site including mains drainage.

The Design

The design is of timber frame construction
with large pre-fabricated sections built off site
to speed up construction. A large
conservatory joins the property and faces in a
South-westerly direction. The red cedar
timber clad exterior hides fibrous newsprint
paper insulation. Increasingly waste paper is
now being used in a finely shredded form
and fire proofed to insulate walls of houses.
Like other types of insulation, the paper is
pumped in. The roof on the north-easterly
side is topped with ‘grass’ - see Figure 1.
Unusually, the bathrooms and their contents
were completely assembled off site and craned
into position when required. Good insulation
combined with placing most windows on a
southerly aspect with a large conservatory
provides plenty of passive solar gain. As vou
might expect from such a design, the extra
heating requirements are small.

3

Photo 2. * 1.
:r buse undet.
© construction.

= e "I

Rainwater- A Natural
Resource Collected

Up until now rainwater has only been
considered useful for watering the garden.
This is certainly still the case at the Integer
House. Here the large conservatory roof
collects many gallons of rainwater
throughout the vear and is stored in a large
5000 litre underground plastic tank. An
automatic watering system for the garden
exists via a series of underground leaky
pipes and the system waters the garden at
the beginning and at the end of the dav in
order to reduce evaporation The exact
amount of plant water is controlled by
monitoring soil humiditv. Another
underground tank holds greywater. Now
greywater is defined as that water that might
typically be discharged from the bath,
shower or hand-basins and is used for
flushing the toilets. An outside filter bed and
a treatment plant supplied by Anglian Water
cleans the greywater before being pumped
into a header storage tank in the roof space.
If the toilet flushing supply from this header
tank runs low, then a back up supply will
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top up the tank from the mains.

The open ground is covered with a general
cover of bark chippings and this provides a
garden that requires low maintenance.
Overall the house uses about 30% less water
than a conventional house. Part of this saving
comes about by having aerated taps and dual
flushing toilets. The toilets therefore provide
the option of using less water.

The roof on the front or northern side is
sedum covered. This is an alpine plant that
looks Jike grass and does not need to be
cut. It retains up to 93% moisture and necd
not be watered for up to 10 months. One
chief advantage of a grass roof is that it
minimises large temperature fluctuations
within the roof structure.

Energy Consumption

In order to consume lower amounts of
energy when going about our daily activities,
low consumption white goodls were installed.
Overall the house consumes tvpically 50%
less than the ordinary household.

Plenty of low energy lights exist around
the house. The Siemens’ Instrabus System

provides four different lighting effects in the
lounge and dining room. The fridge/freezer
in the kitchen only consumes 30W, part of
the reason for this low power being that it is
vacuum insulated for minimum heat transfer.
The dishwasher, washing machine and tumble
drier consume around half the normal
power of standard machines. The house is
s0 generally well insulated that onlv a small
heart requirement is necessary from the heat
pump in the winter. The heating to each
room is ‘zoned’ through a central manifold
and so each room is only heated when
required. This is also achieved through a fast
response  svstem using fuzzy logic to optimise
energy consumption. The low thermal lag
also means the house never overheats.

Automation
in the Bathroom

Most of us are used to a mechanically
operated bathroom to supply water to baths
or basins. The facilities available at the
Integer House means that just placing ones
hands under the mixer tap will turn on the
supply and produce the correct
predetermined mix of hot and cold water.
One little drawback here is that no allowance
has been made for *deadlegs’. This is where
there is always a run of cold water initially
supplied to the basin in the hot run and is
usually run off to waste. The cquipment here
detects the presence of your hands by
passive infra-red. Temperatures for the
bathwater can be set and all tapwater control
is by push button with automatic bath fill.
The toilet also operates by push button,

Intellikey

The house is secured by a kev system with
a difference. It’s called the Intellikey and
each authorised person can be issucd with
one key That kev will allow the individual to
enter permitted areas. This is created in the
initial programming scquence. Although the
svstem is batterv backed. the kev derives its
power from the lock assembly when the kev

Photo 3. Rear of
house with grass roof.
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is introduced. The other interesting aspect 1 Wired for Anything i in the kitchen with an on-line terminal to the
to this is that the kevs can be time : ¢ internet There is also a video display system
conscious. So for example one could issue a to help vou out with  cooking basics in the
key to workmen with permitted access form of DVD vidco demos.

times of between 9-5pm, five davs of the The cooking hob from Zanussi will detect
week, terminating on a given date. the pan when placed on the hob after an

The house is wired for audio, video,
telecommunications and the internet. This
all centres around the 42in. plasma TV
screen in the lounge. Multi-medlia is available

Pressure Relief Valve ¢ Automatic Air Vent Figure 2. Diagram of Hot water installation.
= - .
X -eew]  Sensor C
I Return | ‘ Tt
|
T m : Flow
| 1 | B
| | 0
| i
" Hot Water
| Control Unit E Tap
Expansion - g' --n-.-..--..---...g
Vessel “"N* Q : Spring  Heeetts \ <+ Boiler Connectionn
| Filling H Non-return
Mai Loop/Pressure _ _Valvg '
ans A Gauge Pump & B
Sensor R | Cold Water
Inlet
g Twin Coil Cylinder
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Photo 5. The
‘intelligent’
Zanussi hob.

initial set up procedure to ‘calibrate’ the pan.
The unit measures the magnetic characteristics
of the pan in this initial setup procedure. and
if the pan is a different one. the appropriate
ring on the hob will not turn on. It will also
monitor the temperature o ensure any
liquid enclosed does not boit over.

The washing machine has an optional
delay mechanism and waits for a radio signal
via the mains to wash only in the off-peak
electricity tariff. These machines have also
been engineered to use only half the
amount of water and detergent compared
to normal machines.

Heating and Hot water

Undoubtedly there are substantial savings to
be made in the area of hot water and
heating, and the Integer Housc provides
many relevant solutions. The two principal
sources of heat are provided by the 20
Thermomax solar heat exchanger tubes on
the roof and a decp water pipe ground loop
connected to a heat pump. Top-up heating
from this source is delivered around the
house by floor level radiators within a duct.
Passive solar heating is achieved by the
large south-west facing conservatory and a
system of temperature controlled venting
ensures that heat is exchanged to the living
areas. Internal air circulation passes through
ventilation ducts. The air is fan assisted and
powered by a battery. This battery is kept
trickle charged by photovoltiic panels on the
roof and a wind turbine-generator in the
garden. Again overheaung in the conservatory
on the south side is prevented by vents to the
open air.. Automatic blinds operate according
the brightness of the sun and they provide
between 30-85% shading. The conservatory
was supplied by a commercial greenhouse
manufacturer, Queensbury Structures, and
single glazing is used throughout. The angle
of pitch is sufficiently steep such that it is self

cleaning with any rain that falls.
Figute 2 shows 4 hot water supplv generared
from the 20 Thermomax wibes.

Heat pump
and Groundloop

Tvo 50m bore holes have heen drilled on
site hy a company called GeoScience to
extract heat from the ground. At 30m below
ground level the temperature remains at
abour 12 Celsius and so that heat can be
collected by water in a sealed groundloop
pipe. see Figure 3. A heatpump is really just
a fridge in reverse extracting heat from water
at 12 Celsius underground and passing it to
a heat sink, in this case the hot water tank
the house. In the Integer House the hot
water tank is not like any ordinary hot tank.
It is a tall highly insulated dual cotl tank from
a company called Gledhill (See photo 6). It
can store the water from the solar tubes at
around 77 Celsius.

Convenuonal heat pumps use standard
compressor technology but in terms of heat
generation vou get typically three units of

heat energy out compared to one unit of
electrical energy 1n, 1o run the compressor.
The lower the water temperature that runs
into the ground the more energy one can
extract from the ground. Heat pumps can
also go into reverse and act as an air
conditioning unit in summer taking out heat
from the building and passing it in to the
ground to heat up the ground.

[t has to be stressed that drilling
boreholes 1s at present not economically
viable. The cost to drill and install a probe at
this site was around £33.000. There are
other lower cost shallow groundloop
alternatives where several coils of pipe are
placed at about 2m below ground and could
take benween 300-900m of pipework
provided space is not at a premium.

Solar Tubes

It is great to see some of the hest
technologies currently being used to collect
solar heat. Manv ideas from the very simple
to the more sophisticated have been used
over the vears but this svstem seems to be

Photo 7. Heat pump.
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Figure 4. Energy balance of a flat-plate collector (a), compared to energy balance of a Thermomax collector (b).

the most effective so far. i heat - a matt black surface for example
All surfaces absorb and re-emit heattoa @ warms up generally far quicker than any

greater or lesser extent. The trouble is that ¢ other surface. It is also the best radiator

good absorbers are also good emitters of ¢ surface to emit heat in our homes. (We

don’t see manv matt black radiators though
do wel). However, keeping the temperature
down by passing a coolant like water
through copper pipes to take the heat away
attempts to reduce the heat re-emission

risk. See Figure +a and 4b.

A company called Thermomax has
supplied 20 solar collecting tubes mounted
on the upper part of the conservatory. Some
interesting physics and technology has been
used here. Within an evacuated glass tube
sits a wafer thin solar collector made of
copper. It runs the length of the glass tube
and is attached to a pipe that runs down the
back. This collector plate is coated with a
‘wavelength sensitive” combination of Nickel
and Chromium to maximise solar heat
collection with a minimum of re-emission.
Figure 5 shows the system.

Absorbed heat warms up a fluid with a low
specific heat capacitv. In this case the company
uses Methanol. This liquid then vaporises and
rises up the tube to the top where it enters
the condenser via the valve. Figure 6 shows a
Memotron tube construction.

The valve is macle of a memory metal and
automatically closes off at a specified
temperature. In the Thermomax tubes
that's 95 Celsius or 130 Celsius, depending

Figure 3. Typical ground loop. - |
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¢ on the requirements. The vapour then heats
Figure 5. lllustration of Themomax system . —— . up the water indircctly via the manifold. As

i the heat is taken our, the vapour then turns
back to a liquid releasing its Latent Heat of
Vaporisation. Two lengths of manifold are
available one for 20 tubes and one for 30
tubes giving a tvpical absorbing area of 2m*
and 3m’ respectively. As can be seen from
the graph, mperatures of 80-120 Celsius
can be ach' - ~d. This hot water primary
circuit off-lc * .s its heat into the hot water
tank in the house. As this tank is highlvy
insulated the hot water supply is tvpically
maintained at 77 Celsius. Figure 7 shows a
graph of response curves for different tubes.

And the Future

All technologies used in the house will be
evaluated over twelve months and together
with comments via the internet, that
knowledge will he considered and in some
cases used in real housing projects which
are now just starting across the UK.
Refurbishment of existing properties will
play a key role in the future for Integer for
this is where the greatest demand could lie.
The Integer House itself will undergo its
first technology upgrade in September 1999
as even 6 months in the lifetime of high
technology is now a long time. The house is
intended to be a constantly changing exhibit
to reflect the ‘always achicvable” aspect to
the way we nught wish to live in our houses.
The interest shown in the house has in
some cases resulted in large orders being
placed bringing production costs down on
certain Jow turnover supplier items. In other
areas like the 50m bhore hole, it could result
in others thinking of alternative lower cost
wavs to achieve the same aim. Which ever
i way, the Integer House will serve as a
Figure 6. Diagram of constant remindler that there is a scrious but
Memotron tube i cost effective way to reduce our energy
¢ consumption within the bounds of our
future habitat.
Finallv. I am indebted for the help given

by Peter Colebrook of i & i Lud. the I'T

consultant for the Integer House.
All photographs, with the exception of
¢ the Thermomax tubes are by courtesy of
80 ¢ BRE Professional Imaging. FLEGTRONIGS

Ambient Temp 0°C
Cloudy Day 450W/M’
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In the third part of bis series, David Clark
looks at some of the equipment used.

Introduction

This month I am going to be concentrating
on the electronic principles involved in
equipment used for bio-feedback with
electronic enhancement, and applv some of
these principles to suggestions for some
construction projects to uv.

Equipment
There is a wide variety of equipment available
which comes under the categorv of bio-
feedback with electronics enhancement. Not
only is there a wide range of differing types
of monitor for differing purposes, they also
range from small batterv powered hand-held
monitors with one function for use at home,
to computer based equipment monitoring
several functions simultaneously for use in
clinics by medically trained personnel.
However, as is the case with many
apparently complex svstems, even the most
sophisticated equipment can be broken
down into individual functions, and each
function broken down to simple component
blocks. As has been seen this type of
equipment parallels the biological processes
that are being ‘enhanced’, and can be
broken down into three basic blocks; a
sensor, signal processing, and an output.
The following table summarises the most
commonly encountered types found for the
three categories.

Sensors

As can be seen the sensor type can be
broken down into two categories, those
involving electrodes which monitor
electrical activity directly, and those that
monitor some other parameter and then

convert this to an electrical signal. T'll ook at
these parts separately as thev involve some
quite different processes.

Electrode Type
Monitoring

Monitoring the electrical activity of the body
with electrodes presents some particular
problems. Electrically, a body can be
considered to be a three dimensional object

rolandic fissure :

SENSORS
Sensor

wrist electrode
head electrodes

Monitors

heart electrical activity
brain electrical activity
(‘brain waves’)

neck & shoulder electrodes muscle electrical activity
finger temperature sensors temperature

finger electrodes skin resistance

air pressure sensor blood pressure

air pressure sensor breathing

SIGNAL PROCESSING
Process Function

electrode amplifiers detect signals

isolate ‘patient’

reject interference

amplify transducer signal

may include ‘excitation’ signal
filtering isolates frequencies of interest
Further possibiiities include analogue techniques, digital
signal processing. statistical processes and signal averaging.

transducer amplifiers

OUTPUT

Device Method of Indication
meter needle ‘level’

LED "bargraph’ length of display

light brightness

computer monitor graphic display

audible tone variable frequency

audible tone variable volume

Table 1. bio-feedback equipment blocks.

composcd of an external laver of slightly
conductive material (the skin) containing
various other lavers and objects composed
of different materials with varving
resistivitics, This means electrical paths are
widely distributed and difficult to define, and
anv electrical activity is quickly attenuarted.
Thus the voltages appearing at the surface
are usually verv small. and we are tving to
detect signals having values in the order of a
millivolt for heart signals, and microvolts for
brainwave and muscle signals. Additonally,
the body: like any other conductive material,
acts like an acrial for all the clectromagnetic
radiation in the vicinity which of course
passes straight to a highly conductve
electrode. Finally, conducting electrical
signals down an electrode is not a one wayv
process. As will be seen, electrical currents
can pass in the opposite direction to the one
required for measurements, i.e. into the
body from any electrical equipment it is
connected to, and not necessarily just when
fault_\' or mains powered equipment. This
safety aspect will be examined in a later part.

Amplifying Electrode
Signals

¢ Amplifving small signals needs only the
application of the usual practices for high
gain amplifiers, i.e. careful attention to
screening and ground and signal paths to
avoid instability and oscillation. Cancelling
out signals picked up by the leads from any
extrancous radiation can be thought of as
being in two parts. Most important perhaps
is the use of input amplificrs with good
Common Mode Rejection Ratio (CMRR)
characteristics. This means that only the
difference signal between the input
electrodes is amplified, i.e. the required
signal, and any unwanted interference signal,
which will effectively be the same on each
electrode, is cancelled out. The signals of
interest for bio-feedback are of low
frequency, and so carefully designed low pass
filtering will remove any remaining mains
interference and any higher frequencies.

Signal Types

Of the electrode obtained signals. only the
heart displays a truly periodic waveform. For
muscle activity the voltage picked up at the
electrode depends the activity of that
muscle and will be effectively random in
frequency. For brainwaves the activity can be
divided into ranges of frequencies which
correspond to various brain activitics. The
output from electrodes monitoring the
heart however gives a true indication of the
heart's electrical activity which corresponds
to its physical activitv. Figure 1 shows the
tvpe of signal obtained.

The labels B, Q. R, S, and T in Figure 1
correspond (approximately) to the
following stages of a heart ‘beat’.
€ P wave

the upper chambers (atria) are contracting
€ ORS complex
the lower chambers (ventricles)
are contracting
€ T wave

the atria are relaxing
(Refer to the diagram of heart structure in
part 2 of this series.)
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Figure 1. The Heart
Electrical Output.
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Figure 2. Monitoring Skin Resistance.

The electrical signal caused by the
relaxation of the atria is normally masked by
the electrical signal caused by the ventricles
relaxing - both relaxations occur at the same
time and the ventricles are normally much
larger than the arria.

Analysing these signal types will be
examined in the signal processing section.

Skin Resistance
Electrode Function

Skin resistance is of course a function of the
skin itself, but in fact this is only a minor
contribution. The main influence on skin
resistance is the conductivity of sweat on
the surface of the skin. This is cause by the
presence of chemical ‘salts’ in sweat,
primarily sodium and chlorine,

Monitoring skin resistance is no different
in principle to measuring any other form of
electrical resistance. However there are
some things to be observed - there should
be no dc component to the measuring
current as this can cause polarisation effects
- positive ions move to the negative
electrode and vice versa. Even small dc
currents passing through the skin (as
opposed to the sweat) can cause ulcer
effects over time. For this reason a constant
current source of 100 or 200uA at around
1kHz is usually employed and the skin
resistance determined by the voltage that is
generated. See Figure 2.

Transducer Type
Monitoring

Monitoring parameters via a transducer
presents no more problems than any other
use of such a transducer, in this case an air
pressure transducer. The particular
requirements are for the tvpe of information
which is wanted from the monitoring
process; this is looked at under signal
processing.

Respiration Monitoring

The normal method of monitoring
respiration is via a sealed lightweight plastic
telescopic ‘tube’ that is fixed around the
chest. During respiration the chest expands
and contracts and so the volume of the tube
changes. Since this is sealed the pressure
inside the tube changes, and this is
monitored with a pressure transducer. The
rate of respiration can be determined from
the frequency of change of the pressure
peaks and rroughs, and the depth of
respiration from the amplitude of the
changes. See Figure 3.

Temperature Monitoring

There are two possible monitoring modes
for temperature, absolute temperature and
difference temperature. As discussed, skin
coldness represents a stressed state, and a
difference in temperature between the left
and right hands represents different activity
in both halves of the brain, so two
temperature sensors can be used. One type
of device used for temperature monitoring
in this tvpe of situation is the thermistor.
See Figure 4

Blood Pressure
Monitoring

Devices for automatically monitoring blood
pressure are relatively complex, usually
requiring software control due to the nature
of measuring the blood pressure. As anyone
who has had their blood pressure measured
by one of the manual mercury
sphygmomanometers used in GP surgeries
and clintes will know, this is a fairly coarse
process involving pressurising a cuff until the
blood flow is stopped and then releasing the
pressure, the blood pressure being noted
from the scale as indicated by listening for
the pulse with a stethoscope. This can also
be a little uncomfortable in insensitive hands
however; using clectronic control can be less
intrusive and is more suitable to raking
intermirtent readings to monitor changes
over a period of time as required for bio-
feedback rraining. The principle is the same,
but the electronic detection of pressure at
the points of measurcment is less coarse and
can cause less discomfort. A further
complexity is introduced by the fact that

chest

wall N
N

flexible, expandable,
fixed diameter
sealed plastic tube

Figure 3. Respiration Monitoring.

chest movement
when breathing

/ N

pressure
transducer
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Brainwave Frequericy  Activity

Theta 4Hz - 7Hz Appears to correspond to the day-to-day generation of
imagery and creative activity - sometimes called the
gateway to the unconscious.

Alpha 8H7z - 12Hz Generally corresponds to relaxed vigilance, or meditation.

Beta 13Hz - 20Hz  Generally corresponds to conscious activity.

Gamma >21Hz Generally corresponcls to conscious activity.

Table 2. Braln Wave Frequencies And Activities

failsafe fault detection is essential to ensure
that the cuff cannot overinflate.

Blood pressure measurements are usually
reported as X' over ‘v, e.g. 180 over 90. The
first figure is the svstolic pressure, which is

Signal Conditioning

Apart from amplification of signals the
requirement is for filtering in order to
isolate signals of interest from others. This

seen which is important for all bio-feedback
monitoring. Particular requirements are as
described in the following sections.

Muscle Activity

The muscle activity of interest for bio-
feedback monitoring purposes is the
background tension which causes the
symptoms which are the problem. Fine
tuning the cut-off frequency of the low-pass
filter will isolate this, and then the output is
the sum of all the individual actions within
the muscles of the area around the
electrodes at any particular moment. The
amplitude of the voltage is therefore the
measure of the activity, and no further
processing is necessary.

Brain Activity

For brainwaves the activity is divided into
ranges of frequencies, each of which is
isolated using a bandpass filter. See table 2
for the frequency ranges and associated
brain activitv. Within each bandwidth the
activity is indicated both by the magnitude of
the responses and also how often that
activity is occurring, so following separation
by filtering an integration tvpe technique
which eftectively sums the voltages over
time for each individual range is the measure
of activity required here. See Figure 6.

Heart Rate
Following isolation by filtering, heart rate is
determined by measuring the period of the

waveform i.e. the time between the peak of
the each QRS complex for example. For bio-
feedback an absolute value is not needed,
and a voltage inversely proportional to this
time is a satisfactory output. Refer back to
Figure 1 and also see Figure 7.

would normally be achieved using
conventional analogue circuitry, but digital
signal processing can be emploved in
computer based svstems.

Low pass filtering removes mains and
radio-frequency interference as we have

the pressure produced by the heart when it
contracts, followed by the diastolic pressure,
which is the pressure when the heart is
between contractions. See Figure 5 and the
side text for the automatic procedure for
monitoring blood pressure.

Figure 5. \
Automatic Air
Blood Pressure . Pressure
Monitoring - Tranducer
Software
Controlled.

inflatable
arm cuff

Release
Valve

Controller

Monitor air pressure

Pump air until a sharp change in pressure occurs
count and time the small pulses of pressure
calculate the pulse rate from this

increase pressure until no more small pulses occur
record the pressure - this is the systolic pressure
release the pressure until pulses re-appear

release further pressure until pulses disappear again
record the pressure - this is the diastolic pressure
For bio-feedback the interest is in the reduction of the average e
pressure so a typical manipulation of the readings obtained would be
to take the midpoint of the systolic and diastolic pressures and
compare this to the previous midpoint result obtained, and give a
decreasing output frequency or level for a decreasing midpoint
pressure and vice versa, a decreasing value being the beneficial effect.

\

Air Pump

L K 2K K K IR K IR BX 3 4

Output proportional
to mean blood pressure
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Blood Pressure

If measured automatically this will be
performed by software controlled
equipment, and the form of the output
determined by software design. Once again
an absolute value is not required, it is how it
is changing that is of interest.

Respiration

The parameters of interest here are the rate
and depth of breathing. Like the heart rate,
breathing rate can be measured by
determining the time hetween equivalent
points e.g. the peak for example on the
transducer output waveform, which is cyclic.
Depth of breathing is proportional to the
peak to trough value of the transducer
output waveform.

Skin Temperature
and Resistance

These are slow changing eftectively dc
voltages and so need no further processing
other than gain adjustment.

Output Displays

Visual - The actual values of output are of
no real interest for bio-feedback, what is
important is the amount of change of
activity. with reduction in activity being the
required goal. This means output can be
quite simple to satisfy the requirements of
hand-held or small desktop type equipment,
for example a needle meter, or LED bargraph.
For computer based equipment with the
flexibility atforded by a monitor display, the
amount of information displaved and how it
is displaved is effectively limited only the
imagination of the designer. However,
displays of ‘virtual’ meters or bargraphs are
an easy way of displaying the information.

Audio - A good way of presenting the
output is via an audible signal having a
pleasant tone with a pitch, or frequency,
which varies with the output of interest. This
method encourages the client to relax since
there is no need to concentrate on a visual
display; in fact having the eves closed is
often the best way to encourage relaxation.

Practical Considerations

The main concern is the type and positioning
of electrodes and sensors. Electrodes can
vary, the essential thing being good skin
contact which reduces the resistance of the
connection. The most modern types are self
adhesive and incorporate a conductive gel as
part of the electrode, the gel being of 4
material that is ‘gel-like’ enough to give a
good contact, but firm enough not to be
messy to use. However good contact is the
main criterion and this can be achieved by
holding the electrodes in place on cleaned
skin with a headband for electrodes on the
head or ‘rubber-band’ tvpe devices for finger
electrodes. Apart from a good electrical
contact, the only other important thing is
that they should not be too uncomfortable
or distracting for the subject. For brain wave

monitoring the usual electrode positions are
on the forehead (centre and left or right),
and on the base of the scalp. to left or right
of centre. 1leart rate monitoring is usually by
electrodes on the wrists.

Positioning of transducer type sensors is
determined by the type of device they are
part of and can be remote from the chest
wall monitoring tube or the blood pressure
monitoring cuff if the design requires it.

Training Techniques

The purpose of bio-feedback with electronic
enhancement is to reduce activity, so having
had various electrodes and sensors attached,
the outputs are acknowledged and then the
client taught to relax or achieve whatever is
the required state and the change in output
noticed. The client is then taught to
recognise what they have done in terms of
their emotional state etc. and can then use
that technique to further reduce output and
hence activitv. Eventually the client will be
able to achieve the desired eftect without
the help of the electronic enhancement of
the bio-feedback, it all occurring internally
under the client’'s control.

Patient Safety

One very important aspect of the electronics
that applies to all medical equipment is the
saferv of the patient, and this is achieved by
etfectively isolating the patient from an
electrical current. This may not seem to
apply to hattery powered equipment, but
even a small batterv can pass enough current
to cause skin damage if there is a complete
circuit either between two electrodes, or part
of a case or switch and an electrode.

The danger from mains powered
equipment is more obvious but may present
some surprises. For example it might be
assumed that if a circuit or electrode is at a
low voltage it won't present a hazard. This
isn’t necessarily the case however, it
depends on the current that can flow. To
take account of this there are various
requirements that medical equipment must
comply with, which involve patient isolation,
breakdown voltages, leakage currents,
earthing requirements, and mains
transformers, which are based on various
types and classes of equipment. I'll be
taking a closer look at this in the final part
of the series, as well as taking a look at one
or two more specialised bio-feedback
processes and some equipment closely
related to bio-feedback equipment that are
used for some perhaps unexpected therapies.

For the final scction of this part 1 will

Wrist Isolation _ | Switchable
electrodes amplifiers low-pass
filter
Differential ;
o o o Tmer || Ratedeniy
lifi counter
amplifier output

Figure 7. Heart Rate Monitor.
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make some suggestions for projects that
can easily be put together at home which
will demonstrate some of the principles of
bio-feedback with electronic enhancement,
and which will enable some practice at
physiological control. The guidance of a
trained qualified professional will however
give the best results in most cases.

Projects

For all these projects use a battery powered
circuit to ensure there are no mains isolation
concerns. Even a professional power supply
unit shouldn’t be used in medical type
applications. As will be seen in the final part
of this series there are very specific
requirements for medical equipment safety
particularly regarding isolation from the
mains and each design has to be approved
before it can be used commercially.

Restrict the supply voltage to below 10V,
A PP3 battery is ideal for these projects.

The Output Stage

The required output indication for bio-
feedback with electronic enhancement is
common to all projects and is shown in
Figure 8.

The input to this stage, i.e. the output
from each particular monitor project
therefore needs to be a voltage which falls
as the subject achieves more and more of
the desired ohjective.

Specific design considerations for each
project follows.

Skin Resistance Project

There should be no dc component to any
current flowing through the skin so for a
simple project use dc blocking capacitors
between the electrodes and the circuit.
Restrict the output current flow to around
100 or 200uA. This shouldn’t be a problem
for a skin resistance project with a 9V
supply battery since skin resistance values
will be in the order of a hundred to several
hundreds of kilo ohms. A series resistor
could be added if in doubt.

Since dc can not be used an oscillator or
pulse generator is obviously required.
Frequency isn't critical so something around
1kHz is a convenient value. Radio
frequencies definitely should not be used as
these can cause burns (and also
electromagnetic interference). A square wave
astable is probably easier to construct around
1kHz than a sine wave generator.

Probably the easiest detection circuir is to
measure the voltage developed across the
skin resistance. Although this could simply
be observed on a digital multimeter (DMM),
it is important for bio-feedback training that
the response is quickly and easily observed,
S0 as a minimum requirement an analogue
voltmeter with a large display is needed.
Preferable though is some form of audio
indication as it allows relaxation more easily
without having to concentrate on a small
indicator. A tone that is ‘casy on the ear’ is
also better to allow relaxation, so a sound
waveform closer to 4 sine wave than a square
wave is preferable. For the same reasons
sound reproduction on a reasonable quality
loudspeaker will give better results than by
using a small sounder or even headphones,
unless they are lightweight headphones
which don’t cause distractions. Some form of

Figure 8. Construction LED B h
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voltage controlled oscillator would of course
be needed to convert the detector voltage to
an audible tone; as the original detector
output will be a square wave this will need to
be smoothed o give a dc control signal.

Since the frequency needs to decrease
with relaxation (this is psvchologically more
natural), which corresponds to increasing
skin resistance, the voltage amplifier needs
to have an inverting input unless a scries
resistor has been used in which case the
resistor must be in the more ‘grounded’
half of the voltage divider formed by it and
the skin resistance.

The block diagram of Figure 2 is a good
starting point for the detection circuit.

Skin Temperature Project

The basis of a skin temperature project is a
simple bead thermistor, a device which
changes its resistance with temperarure
and is specificallv designed for temperature
mcasurement purposes. The use of a bead
thermistor, which is physically smaller than
other tvpes of thermistor, is preferable for
this purpose s its response time is shorter
which is better for bio-feedback purposes.

Any form of resistance measurement
circuit can be used here. A suitable method
is a simple voltage divider circuit which
then connects into a similar circuit to the
skin resistance monitor to give an audio or
visual indication according to skin
temperature. The audio frequency should
fall with rising skin temperature.

The block diagram shown in Figure 4 is a
good starting point for this monitor circuit.
A dc excitation for the voltage divider
section could be used instead of the
oscillator as there is no direct electrical
connection to the skin. This would mean
that the rectification and smoothing circuit
would not be needed but a dc offset adjust

might have to be added in its place.

As has been discussed another useful form
of bio-feedback uses the difference in
temperature between the left and right hands
as opposed to absolute temperatures, so a
further adaptation of this circuit would be to
measure the resistance of two thermistors,
one on the same finger of each hand, convert
these to voltages and then feed the difference
between these to the output stage.

Phonocardiography
Project

This simple project is effectively an electronic
stethoscope. By using a sensitive microphone,
or even using a small loudspeaker (around
two to three inches in diameter) in reverse as
a microphone, heart beat can be monitored
and by using suitable filtering and signal
conditioning this beat converted to pulses.
These can be counted and timed to give a
voltage proportional to heart rate which can
then be fed to the audio or visual display and
again used as a basis for bio-feedback
monitoring. If a loudspeaker 1s used as a
microphone, account will be need to be taken
of the fact that it will have a very low impedance.
See Figure 9.

Next Part

In the next, and final, part of this series I'm
going to have a look at one or two of the
less common forms of bio-feedback with
electronics enhancement, and also have a
look at some types of equipment which are
closely relared to bio-feedback types. Plus
I'll also be discussing some of the safety
aspects of the use of this type of equipment,
particularly in regard to connecting people
to electrical equipment especially mains
powered equipment.
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The World's
Oldest Mysteries

Some mysteries, it seems, just won't go
away even when fairly plausible explanations
have been given for them. We are still not
absolutely sure who was involved in the
murder of President Kennedy, and the
conspiracy theorists are never going to let
that one go. Nor is the argument about
whether Shakespeare really wrote the plavs
and poems attributed to him showing any
sign of ending - a new book has just come
out in which author John Michell revives
the controversy.

Now I love a good mystery as much as
anything, but I like it even better when one
of them gets solved convincingly, and it
now seems that three of the oldest and
greatest mysteries of all time are coming
close to solutions. One of them, in fact,
may already have been solved.

The oldest of all is probably the one that
surrounds the lost continent of Atlantis.
There is only one source for this legend,
and it comes from one of the most
influential writers there has ever been -
Plato. He gave a meticulous account of it in
two of his Dialogues, including all kinds of
dates and measurements, and he described
how it was wiped off the face of the earth
by a huge flood. He also said more or less
where it was - beyond the Pillars of Hercules
near what is now Gibraltar. He seems to
have had no reason for writing about it in
such detail except that he wanted the story
to be preserved for posterity.

Some critics have named the site of
Atlantis as the Greek Island of Thira, which

is about half way between Greece and
Turkey: It is one of a group of about twenty
islands, the largest being Naxos and
Andros, and if there had been a huge flood
in this region these islands might well be all
that remains of an old continent. Thira is
not where Plato said Atlantis was, but it is
known to have been destroved, not by a
flood but a colossal volcunic eruption
around 1500 B.C. (Plato dated the end of
Atlantis at around 10,000 BC, but it seems
likely that some copvist misread his figures
and multiplied them all by ten).

Other possible sites for the lost continent
are in the Atlantic Ocean around the Azores,
another group of islands that are prone to
earthquakes and volcanic eruptions one of
which could have destroved an ancient
civilisation; and as far aficld as Bolivia! This
may seem 4 little too far past the Pillars of
Hercules, vet I hear that the intrepid
explorer Colonel Blashford-Snell is mounting
an expedition to the altiplano region around
Lake Titicaca. 1 wish him the best of luck, but
I cannot help feeling, with all due respect to
Plato (who may simply have been told a tall
story by his friend Critias) that vou cannot
wipe out an entire civilisation overnight
withourt leaving some trace some-where.
Atlantis, in fact, may never have existed.

Our second mystery is that old favourite,
the Great Pvramid. There is no doubt that
this exists, and was built with amazing skill
and precision. People have been swarming
all over it, and under it, in recent vears and
we hear exciting accounts of hidden
chambers underneath the Sphinx, locked
doors at the end of tunnels, and myvsterious
alignments suggesting that the pvramids

were built as an earthly replica of the
heavenly constellation of Orion. Mind-
boggling stuff, indeed. Yet, I have been told,
there is a good chance that new evidence
will be found in or under the Great
Pyramid and the Sphinx that will strip away
some of the mystery of these massive
structures. The Egyptians kept meticulous
records of just about everything they did,
so it would be surprising if there was no
record anywhere of them.

Now for the mystery that, many believe,
has been very convincingly solved. You have
all probably heard of Charles Berlitz, whose
best-seller put the Bermuda Triangle on the
map. This is the famous stretch of sea
where ships and whole squadrons of aircraft
vanish without trace. Yet who has heard of
Richard Mclver? He is a geochemist who
came up with a very simple theory to
account for the disappearances. It has to do
with seaquakes, which emit clouds of gas
and generate negative ions on such a scale
that the sea temporarily becomes less dense
- so much so that ships sink. These clouds
have become visible as a kind of fog within
which low-flying aircraft have had all their
electronics wiped out, sending some of
them into the sea.

About five years ago, film maker John
Summers decided to put this theory to 'the
test. He built a huge tank and placed a model
ship in it. Under the tank was an apparatus
designed to simulate the effects of a scaled-
down seaquake. When the button was
pushed, the ship went down like 4 ton of
bricks in a matter of seconds. So the Bermuda
Triangle may well be a real syndrome, but its
causes are almost certainly normal. I think we
can count this one as solved,

The good news for mystery-lovers is that
new evidence can always turn up. In music,
for example, new 'old masterpieces’ are still
being found. My friend Byron Janis found a
new piece by Chopin, while just a couple of
weeks ago another friend of mine went to a
recital where a new piece by a fairly well-
known French composer from the 17th
century (Forqueray) was plaved - it had
been found a few weeks earlier in the Lille
public library, in manuscript, and has never
been printed.

What next? A deathbed confession from
some hoodlum who masterminded the
Kennedy assassination? A letter from
Shakespeare to Bacon thanking him for
that draft of The Tempest? A huge mural in
one of the chambers under the Sphinx
narrating the history of the known universe?

Anvthing is possible.

Uri Geller's novel Ella is published by
Headline Feature at £5.99, and his Little Book
Of MindPower by Robson Books at £2.50,
and Jonathon Margolis’ Uri Geller Magician
or Mystic? by Orion Books at £17,99.

Visit him at www. tcom. co.uk/hpnet/
and e-mail him at urigeller@compuserve.com
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subject we covercd

brietly in the early days of

this column was how to
produce screen shots. This
month we give some further
details with particular reference
to the tools and facilities
available in Windows 98. This, of
course, is something T do every
month as part of my preparation
for this article. However, it isn't
only computer journalists who
need to produce screen shots or
screen dumps. If vou're writing
software documentation of any
sort, or simply providing
instructions for a friend or
colleague, the abilitv to include
screen images is 2 must.

The Basics

First of all let’s trv an
experiment. If vou're sitting at
your PC you may like to try this
out. Simply press the Print
Screen key which is ar the top
left of the cursor control pad
on your keyboard. You might
think that nothing has
happened — certainly it won’t
have caused vour printer to
burst into action as it would
have done in the days of DOS.
However, something certainly
has happened and to find out
what, you need to use the
clipboard viewer. If vou've
never used this tool voull find
it under Start > Programs >
Accessories > System Tools >
Clipboard Viewer. Here'’s the
sort of thing vou'll find.

The clipboard viewer shows
that the clipboard contains a
picture of what was on the
screen when vou pressed the
Print Screen kev: In the case of
my example, there was
evidently nothing on the
screen other than the Windows
98 desktop. Now try a different
experiment and in this case
make sure that there is at least
one Window displaved on the
screen. Now hold down the Alt
key and once again press the
Print Screen key. Start up the
cliphoard viewer again to sec
what’s in the clipboard and
you'll find that this time it
contains a picture of the active
window rather than the entire
screen as it did before.

Saving the Image

So far we've seen how to put
an image of either the complete
screen or just the active window
into the clipboard. However,
this alone is of limited value.
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by Mike Bedford

If you’re writing about software

you’ll probably want to produce

screen shots. Here we investigate
bow to do that.
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Certainly you can use the
clipboard viewer to save the
clipboard contents but the
resultant .clp file isn’t particularly
useful as it can only be read by
the clipboard viewer. To make
use of a screen image in a
document it first has to be
saved in some graphic format
such as .bmp or .tif which can
be recognised by vour word
processor or dip package. A
suitable utility for doing this is
Microsoft Paint which vou’ll
find at Start > Programs >
Accessories > Paint. It's a simple
general purpose bitmapped
graphics package and it’s
eminently suitable for converting
the cliphoard contents into a
standard graphics file. Having
put a screen or window image
into the clipboard using either
Print Screen or Alt Print Screen
respectively, simplv start
Microsoft Paint and either press
CulV or select Edit > Paste. If
the image size currently set in
Paint is less than the size of the
screen or window image in the
clipboard, vou’ll be asked
whether you want the image
size to be increased. You should
reply that the image size should
be increased. If the current
image size is greater than the
size of the image in the clipboard
the clipboard image will simply
appear in the top left hand
corner of the Paint image. In
this case you'd subsequently
have to trim the image to size
50 it’s a good practice to ensure
that the current image size is

always too small. This is simply
done using Image > Attributes
and sclecting some artificiallv
low resolution such as 5x 5
pixels. Once you've done this,
selected Edit > Paste and tell
Paint to increase the 1mage size
to match the image size in the
clipboard vou’ll end up with
something similar to that shown
in the screen shot here — the
screen or Window image will be
displaved by Paint. It’s now a
simple job to save this in your
preferred file format using File
> Save,

Editing the Image

You'll notice that none of the
screen shots reproduced in this
article are complete screens or
complete windows. Insteud,
I've chosen to reproduce just a
portion of the image originally
captured in the clipboard. This
is a common requirement and
is easily done using the editing
facilities available in Paint.
Having pasted the clipboard
image into Paint, use the
“sclect” tool which is the top
right box in the tool bar — the
one which looks like a dotted
rectangle. Now move the
cursor to one corner of the
rectangle vou want (o select and
drag to the opposite corner.
When vou release the mouse
button vou'll find that the
selected rectangle is surrounded:
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bv a dotted line. It can be tricky
to select exactly the right
portion of the screen dump
but if vou get it wrong simply
try again — the first rectangle
will disappear to be replaced by
vour new selection. Once
vou've selected the portion of
the screen or windows vou're
interested in you can transfer
this to the clipboard viewer by
pressing Cul C or selecting Edit
> Copv. Now, of course. vou're
in the same situation as vou
were when you first pressed
Print Screen or Alt Print Screen
except that only your selected
portion of the screen or window
is in the clipboard. So. select
File > New and then select
Edit > Paste. The cut down
image will be pasted into Paint
and vou can save it in a suitable
graphics formart as before.

The Elusive
Pointer

So far we've seen how 1o produce
graphics files containing an
accurdte representation of what
was on the screen or in a
Window. Actually, though, the
image will be lacking one
element of what was on screen,
namely the mouse pointer.
Normally this doesn’t matter
but occasionally vou’'ll find that
it's important to include the
pointer, The bad news 1s that
I've found ahsolutely no way 1o
do this. In other words, it's
impossible to produce a screen
shot like the one shown.

So how did I produce this
supposedly impossible screen
shot? 1 simply cheated, something
which Microsoft Paint provides
you with the facilities to do. What
I mean by cheating is actually
drawing in the mouse pointer. It
does take a bit of practice,
admittedly; but it’s not as hard as
you might imagine. First of all
select View > Zoom > Large Size
and the on-screcn image will be
expanded so that the individual
pixels are visible. Now select the
Brush tool and select the
smallest brush (a single pixel)
from the menu of brush sizes
and shapes at the bottom of the
oolbar. Finally, draw the pointer
a pixel at a time selecting the
colours of the individual pixels
from the colour bar in the
bottom left corner of the screen.
If you make a mistake vou can
either select Edit > Undo or
overwrite your mistakes in the
background colour. [ LEGTRONIGS|
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| udging by the recent
J additions to the ranges of
valves and transformers in
the Maplin catalogue, it is plain
that valve amplifiers are sill
generating a good deal of
interest. With the inclusion of
the KT66 output device to the
catalogue range, readers might
like to try incorporating this in a
power amplifier design as
presented here. A finished
‘monobloc’ made along these
lines is illustrated in Photo 1.
The KT66 is a rather strange
animal, being described as a
'beam pentode!, like a beam
tetrode but where the beam
forming plates also function like
a pentode's suppressor grid
(see also mtroducing Valve
Technology Part 4 by Graham
Dixey, 'Electronics' issue 70
about beam tetrodes). This
came about in order to achieve
the large signal swing capability
of the beam tetrode, but
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Mike Holmes describes a deszgn based on the famous
Williamson valve amp using KT66 Output Valves.

without the attendant problems.
Developed in 1937 by G.E.C.
(who, incidentally, began their
valve research in a shed at
Osram's lamp making works),
the KT66 appeared in time to
see much use by allied forces
during the Second World War,
where it gained a reputation for
efficiency and reliability in less
than ideal conditions. In other
words, it has been well tried!

Circuit Description
The complete circuit is shown
in Figure 1. The output stage is
'cribbed' directly from a
"Williamson' design, initially
released by the then manufacturer
of the KT66, the Marconi/Osram
Valve Co. Ltd. (M.O.V), in 1947,
the only real difference being
that here it is forced' to use a
6.6kW (Ra/a) Millennium 4-20
output transformer (Order Code
DM53H) as T1, instead of the

Photo 1. Finished
working monobloc,

v

|

4.5kW transformer recommended
in the data book, but it has no
problems with this.

Originally an experimental
Williamson triode mode output
stage was tried, but this did not
have enough gain, being limited
to 10 watts. On being 'restored’
to the 'ultra-linear’ distributed
load type. output is approximately
20 watts, which is the same as
for the original Maplin Mullard-
based Millennium 4-20 design.

There needs to be two
special considerations for it,
firstly the RC Zobel networks
associated with each screen grid
resistor of V3 & V4, namely R19
& R23. In each case the addition
of C12. R20, and C13, R22 sets
the upper frequency limit of T1
to roll off by at least 3dB at
some 70kHz - without this there
will be a tendency to HF
instability and perhaps an overly
‘bright’ sound.

V3 & V4 could have plain

includes G234
rectifier and HT
choke in PSU
section.

cathode resistors as per the
original Williamson of 250Q
each, provided that the KT66
valves are a matched pair. In
practice, however, differences
appeared after some use, even
with what started out as a
matched pair, to cause some
imbalance in the output
transformer. Such imbalance
may affect LF performance if
too severe. Adding a system of
manually adjustable bias
trimmers was not satisfactory -
it needed rebalancing at
periodic intervals, a process
that required the aid of an AF
generator and 'scope in every
instance!

Self-Balancing
Valves

Hence a more modern approach
was eventually adopted, resulting
in the 'self biased' valves of
Figure 1. Two constant current
generators, comprising TR1 - TR4
and R23 - R26 inclusive, have the
effect of maintaining an equal
quiescent current of 60mA in
each arm of the transformer
primary at all times. Since the
output stage operates in class A
most of the time this is acceptable,
C16 & C17 providing the extra
for the occasional excursions
into class B mode.

As a result, V3 & V4 need not
even be a matched pair at all in
the first place. One disadvantage
of the method is the power
dissipation of 2 - 3 W each for
TR1 & TR3, these must then
share a finned heatsink of at
least 2 x 4 inches square,
additionally mounted on plastic
stand-offs away from the chassis,
which itself can get quite warm.

This heatsink incorporates a 2
x 4 inch stripboard 'PCB' (0
accommodate TR2, TR4 and
R23 - 26. Thus the assembly
becomes a bolted-on module
and connects into circuit via
twinned wire leads through the
chassis wall.

Strange to tell, the front-end’
part of the amplifier, comprising
V1 to V2a & b, is directly cribbed
from a deflection amplifier for a
(now long extinct!) home made
oscilloscope. The configuration
was, and still is, simple yet very
successful, due in large part to
the employment of the 6SN7
device, a versatile and flexible
double-triode. In fact the circuit
may not work reliably using for
example the ECC83 type. The
low amplification factor of the
6SN7, having a 4 ('mu") of 20,
helps to ensure stability of the
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Supply decoupling
PCB - all other
connections
hard-wired

C1,3,5 = 10nF

bus

M4 = mounting
pillar screws
4mm clear

Figure 2. Stripboard layout,
component side.

+HT1

Earth J

O PCB pins

5 Front-end
HT common
(following 10H)
R2
12k

7 Phase splitter
supply

R1
12k

8 Input stage
supply

circuit. Latterly (comparatively
speaking) the ocral base 6SN7
acquired the GT suffix, the high
quality or 'military spec’ tvpe
being GTY (can also be marked
as the RAF equivalent 'CV1988)).

Ideally, V1, a single valve,
should be the electrical
equivalent, single triode version
63, which even comes encased
in its own metal screening can,
but this seems to be obsolete
and in any case was always very
expensive. So choose which
three pins to use from the 6SN7
as V1, cither 1 -3 or 4 -6, and
ground the three unused pins.

V1 provides direct DC bias to
the phase splitter V2a & b, with
a comparatively large value
anode load chain of resistors R3
& R4, setting the precedent for a
series of 39k values throughout
that consequently gave the
project the carly working title of
‘the 39-kilohm amplifier..."

HF stability is promoted at
this early stage by C7 and R5
providing HF roll-off. V2b
receives the same DC bias as
V24, but this is decoupled to
ground by R9 and C9; V2b is
therefore cathode coupled to
V2a from pins 3 to 6 and
operates in grounded grid
mode, producing equal and
opposite phases on the anodes
with enough 'headroom' to
more than adequately drive the
grids of V3 & V4. R12 is added
to offset the (verv) small loss in
V2b incurred by this method.

Note that every valve is given
a 'grid-stopper’ resistor to
further promote HF stability,
these are R6, R8, R16 & R18.
Similarly a Zobel network, C15
(Mylar type) with R27, is
connected across the speaker
terminals. These measures were
found necessary to help resist
RF breakthrough.

The open loop gain overall is
actually quite modest - you could
arguably operate the amplifier
in open loop mode - but for the
sake of at least ensuring a flat
frequency response some
negative feedback is given by the
chain R28 - 30 with C18. The tap
at R28 is coupled to VI cathode
via C8 where its high value
ensures a smooth LF response.

Construction Notes
Al resistors having an appreciable
voltage drop need to be 1% 2W
metal film types, to handle the
power dissipation in combination
with the high temperature of
their environment; these include
R3. R4, R11 - 14, R19 - 22. The
remainder can be 1% 0.6W 'Min
Res' types. Similarly all non-
electrolytic capacitors should be
high voltage (500 - 1000V)
ceramic tvpes - polystyrene ones

find the heat a bit too much.
The exceptions are C9 as 500V
polypropylene, and C10, C11
and C14 as audio grade 500V
polypropvlene.

All valve holders are octal
type, the layout of these and the
position of T1 on the chassis
being more or less as per
Millennium 4-20 (see 'Electronics’
issue 74 or leaflet XU46A).
Components and wiring are
made directly between the
various solder tags, except for
Cl-6and L1

Because these are specifically
designed for PCB mounting,
they are asscmbled onto a 2 x 4
inch piece of plain stripboard,
see Figure 2 (showing the
component side). This board
doubles as a tag strip providing
an 'earth bus' on one side and
HT supply points for the V1 &
V2 stages on the other. The
board is mounted on a pair of
M4 threaded pillars between V1
& V2 valve holders (see also
Photo 2).

The power supply is exactly as
the Millennium PSU (Electronics'
issue 73 or leaflet XU45Y).
Complete parts lists can be seen
on the web page http://ww.mc-
h.demon.co.uk/vpwrparts.htm.
A stereo pair of 'monoblocs'
configured as described here
have now been operating for at
least two vears without any
problems. Performance is pretry
much as for the Millennium 4-
20 (see Table 1); with the
addition of LF choke ST28F to
the HT line (this is not L1 in
Figure 1), the output noise is
sufficiently minimal to allow
headphones to be used - with
dummy speaker loads, of course!

Next month Mike Holmes will
give details of a GZ34 PSU 1o
use with the amplifier, and to
provide an alternative to the
‘soft start” PSU.

Table 1. Specification for one single monobloc*

Type: Class AB1 push-pull distributed load
Input Sensitivity: 630 mV rms

Output Power: 21 Wrms

Speaker matching: 6 - 8W

Speaker damping;: >40

Signal to noise ratio: 70 - 90dB approx.
Voltage gain: 26 dB

HF roll-off: -3 dB @ 70kHz

LF roll-off: -3 dB @ 25Hz fult power
Distortion: < 0.1%

Valves; 4 (5 with GZ34 rectifier)

Power requirements:

HT supply: 400 to 450V DC

HT current: 130mA average

Heater supply: 6.3VAC @ 3.5A
Mains input (to PSU): 115/230V AC 50/60 Hz
Power consumption: 80 - 90VA continuous
Working temperature: 50°C

*Two 'monobiocs’ are required to form a stereo pair

Photo 2. Internal view of chassis underside.
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PROJECT PARTS LIST o :
)
RESISTORS ]
R1,2 12k 0.6W 1% Metal Film 2 (M12K) §
R3,4,11-14 39k 2W 1% Metal Film 6 (D39K) o
R5,6,8,12 4K7 0.6W 1% Metal Film 4 (M4K7)
R7,20,22 470R 2W 1% Metal Film 3 (D470R) 2
R28 47R 1W 5% Carbon 1 (CATR) 8
R29 2k2 2W 1% Metal Film 1 (D2K2)
R30 220R 2W 1% Metal Film 1 (D220R) 1 xj
R19,21 270R 2W 1% Metal Film 2 (D270R) e L
R27 10R 1W 5% Carbon 1 (C10R) D
RO 1M 0.6W 1% Metal Film 1 (M1M)
R15,17 100k 0.6W 1% Metal Fitm 2 (M100K) Z 3
R24,26 10R 0.6W 1% Metal Film 2 (M10R)
R16,18,23,25 ©6k2 0.6W 1% Metal Film 4 (MBK2)
CAPACITORS
C1,3,5 10nF 1000V Ceramic Disc 3 (JLO4E)
C2,4,6 47uF 450V PC Electrolytic 3 (JL18Uy)
c7 100pF 1000V Ceramic Disc s (BXOTH)
cs 470uF 63V PC Electrolytic 1 (VH480) ou R
co 220nF 500V Polypropylene 1 (FA22Y)
C12,13,18 1nF 1000V Ceramic Disc 3 (JLO3D)
C10,11,14 1uF 500V Audio Grade Polypropylene 3 (KR78K)
€16,17 A47uF 63V PC Electrolytic 2 (VH34M) LAT EST
C15 220nF 250V Mylar 3 all (WWB83E)
VALVES
vi,2 6SN7GTY Double Triode 2 I Ro N s
3,4 KT66 Power Output Beam Pentode 2 (LA98G)
SEMICONDUCTORS
TR2,4 BC182L npn 2 (QBS5K) WILL SAVE
TR1,3 MJE340 npn 2 (QH54))
MISCELLANEOUS You so M E
Chassis AC86 2.5 x 6 x 8in. 1 (XB68Y)
Plain Stripboard 2 x 4in. 2 off 1 pc (JP53H)
L1 10H 10mA Choke PCB mount 1 (HW27E)
Bell Wire Black 1Pkt (BL85G) BRASS
Bell Wire Orange 1Pkt  (BLIOOX)
Hook-Up Wire 3A Brown 1Pkt  (FA28F)
gz%iipl?\»/\lg:;i Stk 11;kt gzgég% Our quality range of thermally balanced irons is
Single Coax Cable im (XR16S) y
TB1 Gold Twin Terminal Posts 4mm 1 (JK24B) now even better than ever. Easier to handle, cooler
M5 Shakeproof Washer 1Pkt (BF42w)
§ GromMEEE S 1Pkt (X63T) to use, each iron is manufactured in the UK and
M3 x 10mm Bolt 1 Pkt (Jy22y)
M3 Nut 1Pkt (JDGIR)
M3 Shakeproof Washers 1Pkt (BF44X) meets CE conformity. There’s an ‘In Handle’
M3 Tag Washer 1Pkt (LR64U)
M4 x 10mm Threaded Spacer 2 (FG39N) adjustable temperature model and burn proof
M4 x 6mm Bolt 2 Jy1i3p)
m;f::iig:;t Sleeving Red 11;kt (%E?(());\?]; lead option and a wide selection of soldering bits.
1mm PCB Pin 1Pkt (FL24B)
T1 20W Valve O/P Transformer 1 (DM53H) That's the good news. The even better news is
VB1-4 Valve Base Octal 4 (CR30H)
VR1 Pot Log 47k 1 (Fw24B) that all our irons are still very competitively priced
Gold Chassis Phono Socket
Single (insulated mounting) 1 (JZO5F)
Finned Aluminium Heatsink, Tel: 01822 613565 Fax: 01822 617598
4 x 2in. approx. offcut 1 pc (FL42V)
M3 x 12mm Threaded Insulated www.antex.co.uk
Plastic Piliars 2 off 1Pkt (FS36P)
M3 Clear x 6.3mm Pillars 2 off 1Pkt (FW34M)
6BA Nylon Washers 1Pkt (BFB4F) -
Stick-On Feet Square (4) 1Pkt (FD75S) W_—_—E—f
25W W/W 8.2R (dummy load) 1 (P8R2) —
Aerosol Grey Primer Paint As req.d B NOT JUST ANY OLD IRON
Aerosol Matt Black Paint As req.d -
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Diary Dates

Every possible effort has been made

to ensure that information presented
here is correct prior to publication.

To avoid disappointment due to late
changes or amendments, please contact
event organisations to confirm details.

September 1999

5 to 7 Sept. ECTS - Computer & Video
Games & Leisure, Earls Court, London.

Tel: (0181) 742 2828,

5 to 8 Sept. PLASA - Light & Sound Trade Show,
Earl Court, London. Tel: (0171) 244 6433.
10 to 11 Sept. Computing Careers
Exhibition, The Royal Horticultural Halls,
London. Tel: (0171) 316 9170.

14 to 15 Sept. Broadband Year 99 -

ATM & Broadband Communications,
Olympia, London. Tel: (0181) 541 5040.
15 to 16 Sept. Electronic Components
Industries Fair, Olympia, London.

Tel: (01799) 528 292,

15 to 16 Sept. Onboard - Electronics
Assembly Exhibition, Olympia, London.

Tel: (01799) 528 292.

21 to 23 Sept. Microwave & Communication
Technology, Wembley Exhibition, London.
Tel: (01322) 660 070.

24 to 25 Sept. AM Radio Show, Donington
Exhibition Centre, Donnington. Tel: (01604)
790 966.

28 to 29 Sept. Business Computer
Systems Show, G-MEX Centre, Manchester.
Tel: (07000) 464 336.

28 to 29 Sept. Call Centre Expo - Telebusiness
& Customer Service, National Exhibition
Centre, Birmingham. Tel: (0181) 742 2828,
28 to 30 Sept. Document & Workflow Mai
Olympia, London. Tel: (0181) 742 2828.

October 1999

1 to 2 Oct. TheatreWorld - Theatre Productions
& Management, Wembley Exhibition Centre,
London. Tel: (01895) 811 986.

5 to 6 Oct. FieldComms - Industrial
Networking Show, Telford Exhibition Centre,
Tefford. Tel: (0171) 417 7400.

6 to 7 Oct. Softworld in Accounting & Finance,
National Exhibition Centre, Birmingham.

Tel: (0181) 541 5040.

6 to 7 Oct. TEST - Electronic Testing Exhibition,
National Exhibition Centre, Birmingham.

Tel: (01203) 230 333.

12 to 14 Oct. Cards UK - Plastic Card
Technology, National Exhibition Centre,
Bimmingham. Tel: (0121) 767 2665.

19 to 20 Oct. Property Computer Show 99,
Barbican Centre, Lordon. Tel: (01273) 836 800.
20 to 21 Oct. Accounting [T, Business Design
Centre, London. Tel: (0171) 221 1155.

26 to 28 Oct. City Information Show, Barbican
Centre, London. Tel: (01865) 204 947.
26 to 28 Oct. Computers & Networks in
Manufacturing, National Exhibition Centre,
Bimmingham. Tel: (0181) 232 1600.

26 to 28 Oct. Mobile Data
Communications Trade Exhibition, Olympia,
London. Tel: (0181) 910 7910.

26 to 28 Oct. Windows NT - Computer
Trade Exhibition, Olympia, London.

Tel: (01256) 384 000.

November 1999

2 to 4 Nov. e-business expo 2, Olympia,
London. Tel: (0181) 910 7910.

8 Nov. PC@Home+IntemetdAll, G-MEX
Centre, Manchester. Tel: (01895) 630 288.
10 to 11 Nov. Data Warehousing, Olympia,
London. Tel: (0181) 879 3366.

16 to 18 Nov. Digital Media World, Wembley
Bxhibition Centre, London. Tet: (01244) 378888,
16 to 18 Nov. Electronic Information
Display, Sandown Exhibition Centre,
Sandown. Tel: (01822) 614 671.

17 to 18 Nov. JAVA - Computer Software
Trade Exhibition & Conference, Olympia,
London. Tel: (01256) 384 000.

17 to 18 Nov. Softworld in Sales & Marketing,
National Exhibition Centre, Birmingham.

Tel: (0181) 541 5040.

December 1999

7 to 8 Dec. Digitat Signal Processing & Data
Acquisition, Sandown Exhibition Centre,
Sandown. Tel: (0181) 547 3947.

7 to 9 Dec. Online Information, Olympia,
London. Tel: (01865) 388 000.

Please send details of events for
inclusion in ‘Diary Dates’ to: News Editor,
Electronics and Beyond, P.O. Box 777,
Rayleigh, Essex S56 8LU or e-mail to
swaddington@cix.compulink.co.uk.
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Equiinet’s Jones Slams BT for
High Speed Multimedia Sham

Bob Jones, chairman of Equiinet has critised BT
for holding back nationwide high speed
multimedia services that would bring voice,
video, and Internet capability over BT’s existing
network to every home and business in the UK.

“BT is attempting to blackmail the country.
Company officials are on record as saying that the
telecoms operator would be ready to roll out
high-speed data access countrywide over existing
telephone lines by August 1999,” said Jones.

According to a recent report in the Sunday
Times, BT has told OFTEL, the industry watchdog
and the UK government that it cannot justify
proceeding with the high speed network unless
demands from BT’s rivals for equal access to the
network are rejected.

BT would use a technology called ADSL to more
than quadruple the bandwidth of conventional
telephone lines. This would enable multiple data,
voice, high speed Internet or video services to be
run over a standard BT telephone line.

“The majority of the network that BT would use
to roll out ADSL services was built in the days
before deregulation when BT was the state telecom
provider. BT owes it to the nation’s industry,
educational establishments and consumers to
make high speed multimedia and Internet access
available over its networks,” said Jones.

“I have spent the majority of my working life
building products and companies that enable
information to be brought closer to people. BT is
dacting against the public interest in holding back
a service which is a national resource and is vital
in keeping British industry competitive.”

For further details, check: <www.equiinet.com>.

Contact: Equiinet, Tel: (01793) 603700.

3Com President Outlines
Key Emerging Network
Technologies

Networks will soon become as commonplace as
electricity, and as necessary, available, affordable
and easy to use as today's telephone network
according to 3Com president and COO Bruce
Claflin speaking at a kevnote address to CAMP
Expo '99 in the US in June.

"As networks become more pervasive and

accessible, people's quality of life and well-being
will be substantially improved," said Claflin.

During his remarks, Claflin stated that
achieving a new level and quality of personal
access will depend on the deployment of
converged networks, or combining the current
parallel voice, video and data communications
systems on a single network infrastructure,

"Converged networks will offer a fundamentally
lower total cost of ownership, and the ability to
deliver voice, video and data applications,
including e-commerce, distance learning, next-
generation call centres and telemedicine."

Claflin explained that the new applications
supported by converged networks will make it
possible for users to collaborate, learn, and transact
business in real time across the globe, unlocking
significant competitive advantages, and enabling
entirely new ways and methods of doing business.

"Converged networks are not only something
for the future - they are being deployed in
enterprises today to achieve both
telecommunications cost savings and competitive
advantage," Claflin said.

For further details, check: <www.3com. com>.

Contact: 3Com, Tel: (0118) 927 8200.

Conference Finds Remote
Working is Only for the
Well-Connected

Small businesses
are not adopting
technology for
remote working.
This is the
finding of a
telephone poll of
150 companies
with less than 50
emplovees
conducted by
ACC Telecom as
part of its
campaign to
understand the communications needs of small
and medium-sized enterprises.

Teleworking, and other issues faced by small
businesses, was discussed at the British
Chambers of Commerce (BCC) National
Conference, Glasgow Conference Centre June 3
and 4, 1999, sponsored by ACC.

88% of companies said that less than one in
four of their suaff are teleworkers, despite
indications that larger companies are fully
adopting teleworking. Only 7% expect this
number to grow within the next five years. In
addition, 59% of companies said that less than a
quarter of their staff have e-mail addresses or
desktop Internet access.

However, 91% of companies acknowledged the
benefits, and importance to their business, of
communications technology such as the Internet
and mobile telecoms. And most (60%) small
businesses have set up their own Web site.

For further details, check: <www.accuk.co.uk>.

Contact: ACC Telecom, Tel: (0800) 980 1601.
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ound is transmitted
through the air in the
form of pressure waves.

The human ear will respond to
sound waves in the approximate
frequency range 20 to 20000
cycles per second (20Hz to
20kHz) although this figure
varies considerably between
individuals. Sound waves outside
this frequency range are also
readily propagated through the
air but are simply not audible
to the human ear. Many other
species are capable of producing
and detecting sound over
different frequency ranges
which can vary considerably.
For example, it is well known
that dogs can usually hear
much higher frequencies than
their owners and pigeons
produce very low frequency
sounds. Some species, notably
bats, use high frequency
‘ultrasonic’ bursts to provide
positional information, analogous
to radar on a boat or aircraft. In
addition to natural sources,
ultrasonics are also used in a
host of technological applications
from ultrasonic tape measures
to security systems.

In this article we look at a
circuit that is capable of detecting
and converting high frequency
(ultrasonic) waves to an audible
frequency. Its uses include
testing ultrasonic transducers
and listening to the normally
inaudible ultrasonic emissions
from bats and other creatures.

Circuit Description

Figure 1 shows a block diagram
of the ultrasonic detector
circuit. The circuit operates by
mixing the signal from a
microphone with the output
from an oscillator operating in
the ultrasonic frequency range.
The result is 2 complex mixture
of frequencies including the
frequency difference between
the incoming signal and the
circuit's internal oscillator. The
audible components of the
output are filtered and
amplified. Using this method it

Tuning

Ser 8itivity

VOl
Volume

DETECTOR

Gavin Cheeseman describes a low-cost,
wideband ultrasonic detector.

is possible to effectively
rranslate part of the ultrasonic
frequency range 1o a much
lower audible frequency range.
For example if the internal
oscillator is tuned to a
frequency of 30kHz and the
microphone detects an
ultrasonic emission at 31kHz,
when the signals are mixed the
resulting output will include
1kHz (the difference herween
the two frequencies) which is
audible to the human ear. Of
course an incoming signal at
29kHz will also produce a 1kHz
difference frequency but for
many applications this does

not present a serious problem.
The circuit diagram of the
detector is shown in Figure 2.
Power is connected between
terminals P1 (+V) and P2 (OV)
via switch S1 which is
connected externally. Diode D1
is included to avoid damage to
the circuit if the power supply
is connected with the wrong
polarity. Input signals from the
microphone or transducer are
applied to the circuit on
terminal P3. Capacitor C2
blocks DC and also forms part
of a simple high pass filter. The
signal is fed to the non-
inverting input of operational

amplifier ICla. A 1/2 supply
voltage reference is provided
by resistors R1 and R2 which
form a potential divider. C1
helps to ensure that noise on
the supply rail does not find its
way back to the op-amp input.
The maximum gain of IClais
determined by the feedback
network comprising resistors
R4 and RS. Capacitor C3 produces
a rolloff at low frequencies
enhancing the high pass effect
and blocking DC.

The output from ICla is
connected to the next stage
(IC1b and associated
components) via C4. This stage
acts as an inverting amplifier.
RG6, R8 and C5 provide a voltage
reference for the op-amp whilst
R7, R9 and VRI set the gain.
VR1 allows the user to reduce
the gain of the amplifier in the
presence of high input levels.
Capacitor C6 provides high
frequency supply decoupling
and is mounted close to IC1.

The output of IC1b is
connected to the signal input
of IC2, an MC1496 balanced
modulator which is configured
as a product detector. A second
input to the device is taken from
the oscillator formed by 1C4
and associated components.
The two signals are mixed by
IC2 producing a series of mixing
products at the output on 1C2
pin 12. The output is filiered by
R19, C11 and C12 to remove
high frequency components of
the signal whist retaining most
of the audio frequency content.
C13 provides interstage coupling
and VR2 controls the volume of
the audio signal.

The filtered signal is applied
to the input of IC3, a small
power amplifier based around
the LM386N-1 IC. This provides
enough output to comfortably
drive headphones. R20 and C16
help to ensure that the amplifier
output is free from high frequency
instability. The amplifier output
is made available on P5.
Resistor R21 is included to limit
the output 1o a suitable level
for driving headphones.

Transducer

Preamplifier

Product Low pass Audio
detector fitter Amplifier Output
Variable
Frequency
Oscillator
Figure 1. Block diagram.
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Figure 2. Circuit diagram.

Building
the Detector

Most methods of electronic
construction are suitable
including matrix board and PCB
as long as basic layout rules are
adhered to. This includes running
a separate set of supply rails for
the preamp, oscillator, mixer and
power amplifier stages joining
only at the power supply input
pins. Each section should have
its own high frequency supply
decoupling capacitor, and bulk
decoupling capacitor C14 should
be positioned close to the
power supply input pins. This
will help to minimise unwanted
noise on the power supply rails
and reduce the possibility of
instability. Furthermore, it is
recommended that the
components of each stage are
physically grouped together. In
particular, power amplifier
output wiring should be kept
well clear from the microphone
input section of the circuit. All
leads should be kept as short as
possible to avoid picking up
unwanted radio frequency
signals and to prevent coupling
of the internal oscillator into
the audio frequency stages.
When constructing the circuit
it is probably easiest to start with
the low profile components
such as resistors and diodes as
these can be awkward to fit once
the larger components are in
place. As usual, it is recommended
that DIL sockets are used for
the IC's as this helps to prevent
the devices being damaged
during installation.
Constructors are reminded to
take care when fitting polarised
components. As well as
preventing the circuit from
working properly, incorrectly
connected components can
overheat or explode. Pinout
details for the ICs used in the
circuit are shown in Figure 3.
Electrolvtic capacitors are
polarised and must be connected
correctly The negative lead of the
capacitor is usually indicated by
a negative (-) symbol on the side
of the component body. The
negative lead is also usually the
shortest of the two. Diodes are
also polarised with the cathode
being indicated by a band at
one end of the component.
The potentiometers may
either be mounted onto the
circuit board or be wired off
board using short lengths of
hook-up wire. In either case, it
is important to ensure that the
controls are secured properly
when the unit is finally assembled.
Do not rely on the leads to hold
the potentiometers in position
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as these can be easily broken.
The microphone is connected
off board using a short length of
hook-up wire. Again, try to keep
the leads as short as possible. If
it is necessary to use leads longer
than a few cm, for lavout or other
reasons, it is recommended that
miniature coaxial cable is used
to prevent stray pickup. When
connecting the microphone
make sure that the case (-)
terminal of the device is connected
to OV (P4) and that the "+
terminal is connected to P3.

The audio frequency output
is connected to a stereo
headphone socket. For most
purposes it is probably easiest
to connect the headphone
socket such that the left and
right channels of the headphones
are in series. This is illustrated
in the wiring diagram shown in
Figure 4. Parallel connection is
also possible with 32Q
headphones but there is little
practical advantage in this.

The battery is connected to
the circuit using a standard PP3

tvpe battery clip, with the
connection made via switch S1.
Although the switch is shown
separately on the wiring diagram,
it actually forms an integral part
of switched potentiometer VR2.

Testing

Before testing the unit, double
check the circuit connections to
make sure there are no visible
errors. Also look over the solder
joints. One of the main reasons
for the initial failure of

constructional projects is poorly
soldered connections. Short
circuits caused by solder
splashes and dry joints where
the solder has not flowed
properly are common problems.

It is recommended that the
completed circuit board is
initially tested before final
installation into a case. This
avoids the nced to remove
everything from the case if, for
whatever reason, the unit does
not work first time. The circuit
is designed to operate from a
9V PP3 type battery, and an
alkaline type is recommended.
The +V connection is made to
P1 and OV (battery negative) is
connected to P2. If a multimeter
is available, this may be connected
in series with the +V power
supply rail to enable the current
consumption to be monitored.

Set the volume control to
minimum (ensuring that the
on/off switch which forms part
of the volume control is in the
'on' position), connect a pair of
headphones to the unit and
apply power to the circuit.
Under normal circumstances,
the quiescent current
consumption with the volume
set to minimum should be
considerably less than 100mA.
Slowly increase the setting of
the volume control until
background noise is audible.
Adjust the tuning control to the
lowest frequency setting. At ihis
setting it should be possible to
hear the highest frequency
components of speech (pitch
shifted) if you speak into the
microphonc. To test the
detector at higher frequencies
an ultrasonic source will be
required. Shaking a set of keys
or a few coins will usually
produce sounds rich in
ultrasonic components up to at
least 30 or 40kHz. This should
be detectable a few metres away
from the microphone when the
unit is correctly tuned. Another
useful source of ultrasonics is
40kHz ultrasonic transducers.
These can be driven from a
suitable signal generator or
oscillator as shown in Figure 5
taking care that the maximum
input voltage for the transducer
is not exceeded. The response
of the wransducers is centred
around one specific frequency
and drops off notably either side
of this point. Therefore tuning
of the signal source can be quite
critical if maximum output is to
be achieved. When you have a
reliable source, check that the
sensitivity control adjusts the
input sensitivity. If evervthing
appears to be working correctly,
the circuit board can be
installed into the case.
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Figure 6. Mounting the circuit board.

Circuit Board
Installation

'The recommended case is Maplin
stock code BZ73Q although
other suitable cases may be used
as long there is sufficient room
for the circuit board and associated
components. The circuit board
is mounted into the case using
four spacers as shown in Figure
6. It is also necessary to drill
holes in the case for the
microphone, headphone socket
and panel mounted components.
The front panel label design
shown in Figure 7 may be used
as an approximate guide to hole
positioning.

When positioning the circuit
board in the box, please don't
forget to allow enough room
for the bartterv. The battery mav
be fixed in position using a small
self adhesive pad or a suitable
self adhesive clip. The second
option is preferable as it makes
the battery easier to change.

The microphone is mounted
on the inside of the case as
shown in Figure 8. Where
possible, it is advantageous to
reduce the acoustic coupling
between the microphone and
the case or circuit board as the
circuit is very sensitive and
tends to pick up movement in
the area of the case. Use of

Sensitivity

Figure 7. Front panel label.

JOff
Volume

silicone rubber sealant to fix the
microphone onto the case
reduces this problem although
it is alwavs present to some
degree. Trv 1o avoid getting any
of the sealant over the front of
the microphone element as this
mav impair the performance of
the circuit considerably.

Frequency
Calibration

The detector tunes over the
approximate frequency range
10kHz to 80kHz although it
should be pointed out that the
sensitivity of the microphone is
considerably reduced towards
the top end of the range. A
white tuning scale has heen
included on the label but is not
calibrated as there may be some
variation in operating frequencv
due to component tolerances.
Also some readers may wish to
modify the tuning range (more
on this later). If a frequency
counter with a high impedance
input is available this may be
connected to IC4a pin 1 to
display the operating frequency.
The frequency at various points
on the runing dial may then be
marked on the scale. 4

. Using the

Ultrasonic
Detector

Just how the detector is used
will depend on the application.
There are, however, some
general points to consider
when operating the unit. Firstly
the unit is quite directional
particularly at high frequencics
and is considerably more
sensitive to sources in front of
the microphone. It is therefore
advantageous to slowly rotate
the detector if vou are unsure of
the direction of the ultrasonic
source. If you expect the source
t0 be quite weak it is best to
start with the sensitivity set to
maximum and slowly back off
the control if the input level
becomes excessive. The
sensitivity control is provided so
that the gain of the input stage
may be reduced if overload
occurs. Signs of overload include
distortion and clicking at the
output on signal peaks. If the
sound output from the unit is
simply too loud it is best to use
the volume control in preference
to the sensitivity control.
Because the drive waveform
to the product detector is not
sinusoidal, some harmonics are
present. Although for many
general purpose applications
this does not present a problem,
under some circumstances
spurious signals may be detected
when the tuning control is set to
frequencies where there is in fact
no signal present. In many cases
the spurious responscs arc
considerably weaker than the
true signal and may be ignored.

Applications

As mentioned the Ultrasonic
Detector is designed as a general
purposc unit that can be used
to detect the output from a
number of different ultrasonic
sources. A typical use for the

Figure 8.

Mounting the

microphone. Hde
incase
Case

Silicone nubber

Mcrophone
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unit is to detect the ultrasonic
emissions naturally produced
by some animals. Bats are well
known for producing such
emissions. Different species of
bat produce emissions at
different frequencies each with
a characteristic envelope shape.
The ultrasonic detector covers a
frequency range which includes
a number of UK bat species
although it should be noted
that some types of bat produce
emissions at a frequency in
excess of 100kHz and are
therefore outside the range of
the detector. Most species
actually produce sounds over a
range of ultrasonic frequencies.
Readers requiring further
information may wish to consider
contacting their local bat group
who may be able to provide
detailed information regarding
the detection of bats and
specific frequency characteristics.

Important Note
Bats are protected by strict
legislation, It is illegal to

intentionally disturb bats or their roosts.

Other animals also produce
ultrasonic emissions, notably Insects,
Examples include ants and moths.,
Some species have specially adapted
organs specifically for producing such
emissions, The emissions are often
in the form of pulses covering a wide
frequency range and are thought to
form one of a number of methods of
communication,

Applications in
Technology

The detector may be used for
checking the presence of
emissions from ultrasonic
remote controls and alarm
systems operating at 40kHz.
When working correctly, the
output from ultrasonic transducers
can be considerable, so it may
be necessary to initially reduce
the sensitivity control. Starting
with the volume control at
minimum, slowly increase the
setting until the background
noise is just audible. Adjust the
tuning control across its range
listening for the whistling sound
produced when the ultrasonic
emission is detected.

In a similar way the unit can
be used to make subjective
comparisons of the output level
from different ultrasonic
transducers. There are also
many other potential sources of
ultrasonic emission in and
around the home. For example
televisions and computer
monitors often produce quite
high levels. It is quite surprising
just how noisy the environment
can be outside the normal
audible frequency range.

Experimental
Modifications

There are a number of
modifications that can be made
to the ultrasonic detector circuit
to improve performance or
tailor the response to a specific
application.

The crystal microphone
specified has a relatively wide
frequency response but the
sensitivity drops off rapidlv as
the frequency increases and the
response is inevitably poor at
the top end of the detector’s
tuning range. The device was
chosen for its low cost and
availability and in this respect
provides good performance.
There are however many
alternatives and some readers
may like to experiment with
different microphone
arrangements with a view to
improving high frequency
performance. For example, if
you are interested in detecting
emissions on a specific
frequency you may wish to
consider using an ultrasonic

transducer. These have a very
sharp response but offer the
advantage of providing good
sensitivity. A typical example of
this type of device is Maplin
stock code HY12N). These
tvpically operate in the region
of 40kHz and are sold as a
matched transmitter/receiver
pair. This is a useful frequency
since some of the more
common species of bat produce
emissions in this region as well
as many electronic ultrasonic
svstems. The receive element is
very directional and provides
good sensitivity. The device may
be connected directly in place
of the specified crystal
microphone without the need
for any other changes to the
circuit configuration. Due to the
sensitivity of the transducer, it
may be necessary to reduce the
detector’s sensitivity control to
avoid overload.

The types of transducer used
in some camera autofocusing
systems are often sensitive over
a very wide frequency range
often up to more than 100kHz.

PROJECT PARTS LIST
RESISTORS (all 0.6W metal film)
R1, 2, 6, 8, 15,
22,23 10k Min Res 7 M10K
R3 1M Min Res 1 M1M
R4, 7,9, 10, 11, 12,
13, 14, 19, 26 1k Min Res 10 M1K
R5, 25 100k Min Res 2 M100K
R16, 18 2k7 Min Res 2 M2K7
R17, 21 120R Min Res 2 M120R
R20 4R7 Min Res 1 M4R7
R24 470R 1 M470R
VR1, 3 Pot Lin 10k 2 FW02C
VR2 Sw Pot Log 10k il FW63T
CAPACITORS
C1, 5, 13 GenElect 10uF 63V 3 AT77)
c2 Ceramic 1000pF 1 WX68Y
(276 4l et Al alo) Ceramic 10000pF 5 WXT77J
Ce, 7,9, 10, 15,
16, 19, 20 Minidisc O.1uF 16V 8 YR75S
C14, 17 GenElect 100uF 16V 2 AT40T
Cc18 Poly Layer 0.047uF 1 WW37S
SEMICONDUCTORS
IC1, 4 TLO72CN 2 RAG8Y
IC2 MC1496P al QH478
IC3 LM386N-1 1 UJ37s
D1 1N4001 1 QL73Q
MISCELLANEQUS
DIL Socket 8-Pin 3 BL17T
DIL Socket 14-Pin i BL18U
P1-6 Pin 2145 6 Pins FL24B
SK1 Jack Skt Sto il HF92A
Crystal Mic In Metal 1 HY33L
L/Weight Headphones i RIO6E
ABS Box 2853 4 BZ73Q
PP3 Clip 1 HF28F
Knob K7C il YX03D
Knob K14B 2 FK39N

Also electret microphones have
varying degrees of response
outside the audible range. The
sensitivity tends to tail off rapidly
as the frequency is increased
but the response curve is
generally not smooth. Therefore
some useful peaks in response
often occur well into the ultrasonic
range. Of course electret
microphones require biasing and
this means that as well as the AF
output there is also a standing
DC level across the microphone
terminals. This does not present
a problem and the input of the
ultrasonic detector on terminal
P3 will happily accept an input
signal with a DC offset as long
as this does not exceed the
supply voltage.

Modifications to
the Oscillator

As mentioned the oscillator
waveform feeding IC2 is not
sinusoidal and as a result
spurious responses may
sometimes be noticeable.
Although not a problem for
general purpose use there are
some applications where it is
advisable to reduce spurious
responses to a minimum. Where
this is important, the internal
oscillator output at IC4b can be
disconnected and a low
distortion signal generator used
to drive the input of IC2. Take
care not 1o overdrive the inpur;
the signal level should be limited
to 300mV rms, although in
practice a considerably smaller
signal level will often be required.

Changing the
Tuning Range

If you wish to modify the tuning
range of the detector this may
be achieved by changing the
value of C18. Reducing the value
will shift the tuning range up in
frequency and increasing the
value will shift the range down.
The maximum operating
frequency is determined by the
characteristics of the operational
amplifier.

Output Level

The audio output level of the
detector is limited by R21 so as
to reduce the possibility of
overdriving the headphones
and damaging your hearing if a
loud signal is detected. This
resistor may be linked out where
a higher drive level is required
but care must be taken to limit
the volume level.
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he Velleman PersonalScope
Tis not a graphical multimeter

but a complete portable
oscilloscope that can be held in
the hand and all this for the
equivalent cost of a good quality
multimeter, priced at £124.99 (order
code VI30H). Its high sensitivity
- down to SmV/div - and extended
'scope functions make this unit
ideal for the hobbyist, service
engineer, automotive and
development engineers. Also
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Video slignal
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A PORTABLE HAND-HEL
OSGILLOSGOPE

22 2222020000002 00000000000c0¢00TC

Jobn Mosely reviews this latest piece
of test kit from Velleman.

because it does offer excellent
value-formoney; the PersonalScope
is well suited for educational
use in schools and colleges.
The device is suitable for
measurements on audio
equipment, mains voltage
applications, digital signals, a
variety of sensors and signal
analysis in automotive
applications. It's ultra fast full
auto setup function, makes
measuring waveforms verv easv.
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In-Use

The PersonalScope can be
powered from batteries,
preferably re-chargeable, |
or from a standard 9V DC \Ap.
mains adaptor. Although
the 'scope is designed for
hand-held use, I have to sav
that vou need a large hand to
cope! But this does not distract
from its portability, and hence
its versatilitv. And for simple
fautt-finding whether on

individual pieces of equipment,
backplancs or large installations,
then the PersonalScope is
extremely useful. I would not
advocate using the device for
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accurate, dertailed analysis, but
in auto mode, you can swiftly
move round a circuit looking
for faults.

The input signal is applied via
a single, standard BNC socket
which is next to the 9V DC input
socket. Tactile switches on the
front, with the current operating
mode displayed on-screen
select all functions. Many of the
switches are multi-function and
are continuously pressed until
the desired function is selected.
In auto-mode the ’scope reacts

very quickly to the input signal,
and adjusts for level and
triggering. The marker function
allows for measurement of
voltage, time and frequency.
The contrast ‘control” has a very
wide operating range which
means the ’scope can be used
in variable ambient lighting
situations - from behind bays 10
outside. Auto shut-off will help
to preserve batterv life for if the
’scope is left inactive for a
length of time then it will
automatically turn off.

Product

Order Code

Price inc. VAT

PersonalScope HBS5

VI3OH

Please note that we do not expect to have the PerosnaiScope in stock untit September 1999.

£124.999

The PersonalScope is
suitable for a wide range
of servicing applications.

In the ‘DVM’ mode, it will
display true rms, dB, peak-to-
peak and DC volts. Note that
for high voltage measurement a
suitable x10 probe will be
required. The images give a
good indication of the tvpical
waveform displays.

In Conclusion

The sample we received from
Velleman was a prototype, and
so came without any accessories
and manual, therefore, [ can not
comment on how good the
manual will be in the final retail
version. However, for anvone
reasonably au-fait with using
'scopes, thev will be familiar
with the ‘feel’ and operation of

the PersonaiScope.

The "scope performed verv
well handling a variety of input
signals and adjusting itself
accordingly. The display being
only 4 x 128 pixels limits the
practical use of the ’scope - it is
not suitable for accurate, detailed
measurements. But for simple
diagnostic repair work, then the
SCOpe comes into its own.

The ‘scope will be supplied
with a basic probe, that is a test
lead tvpe with alligator clips and
a soft protective carrving case
and manual. Even taking into
account the limited display, the
PersonalScope at £124.99 ofters
excellent value for money, and
will be a very useful addition to
the electronic toolbox.

Maximum sample rate:
Input amplifier bandwidth:
Vertical resolution:

LCD Graphics:

dBm measurements:
True rms AC measurement:
Time base:

Input sensitivity range:
Supply voltage:

Battery option:

Battery life:

Safety:

Dimensions:

Weight:

5MHz

1MHz (-3dB at 1V/div setting) 1MQ//20pF (standard oscilloscope probe)

8-bit (6-bit on LCD)
4 x 128 pixels

From -73dB to +40dB (up to 60dB with x10 probe) 0.5dB accuracy
From O.1mV to 80V (up to 400V rms with suitable x10 probe) 2.5% accuracy

20s to 2us/div

5mV to 20V/div in 12 steps (up to 200V/div with x10 probe)

9V DC min 300mA

Alkaline type AA or NiCd/NiMH rechargeabie (5 batteries required)

SPECIFICATION

Up to 20 hours with Alkaline batteries
Conforms to IEC1010-1 600V CATII, poliution degree 1

105 x 220 x 35mm.

395g (140z.) (excl. batteries)
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Versions

The A77 was originally introduced in 1967,
¢ and was basically a ‘stripped down’ version
¢ of the studio machines of the day. There
were plenty of inputs, the potential to be

i remotely-controlled and a transport that

treated your tapes with the utmost respect!

i Unusually, the A77 could be switched
between IEC (European) and NAB (US)
i playback equalisation curves. The latter
¢ feature adds to the deck’s flexibility,

¢ particularly as a source deck for CD
mastering. The machine was capable of

accepting professional 10%2in. spools at a
00 0000000000000 0060060000O0C0O0OCOCGOEO

time when most machines wouldn’t take
Look around, and you may find an analogue tape a“Ytlgmg bifégjtf = e fdeS‘%‘ttﬁYO“
. 5 s 5 ., could recor e faster speed wi
bargain. Martm Pipe gives us a low-down on the classic e onal standarPla i b sl
P Revox A77. SE e ¢ have enough running time to capture an
hour’s concert - something that encouraged

Phete .
e Revex ATT =

e may live in the digital age, but a lot
WOf us have analogue tape recordings

that we want to play - or, better still,
commit to CD before they deteriorate beyond
the point of no return. Fortunately, the price
of CD-R hardware has fallen to an affordable
level in recent years. Stand-alone CD
recorders can be acquired for less than £400,
while a trawl around the Internet or your
local computer fair will reveal PC-based CD-R
writers that start in price from £120. One of
these, plus a decent soundcard and the
appropriate audio processing/mastering
software, will convert your PC into a powerful
small-scale CD production system. A series
deuailing how was published in the issues 121
10 125 of Electronics and Beyond. In time,
we'll be publishing “follow-up’ articles thart will
bring this series up to date. In this issue,
though, we’ll be looking at how tape
equipment can be restored.

Where to Buy

After all, it’s fine being able to make your
own CDs - but there’s little point if you can’t
replay the media that you want to transcribe!
Many readers will indeed have old recordings
on quarter-inch tape. In this article, we’ll be
examining the Swiss-made Revox A77 - a

e 6ff

&

Lyt fodlit,

very popular high-end reel-to-reel tape deck
of its day. The same basic servicing
principles will apply to most, if not all,
similar machines though. You'll often see
A77s turning up at audio retailers and
secondhand music stores - the Music
Exchange in London’s Notting Hill being a
good example. Another excellent place to
look is the Internet, since thev crop up from
time-to-time on private web sites and ‘for
sale’ newsgroups. Very occasionally, you find
them at jumble and boot sales - I've come
across two Revox machines in this wav.

high-fidelity recording. The basic A77 has
two recording speeds - 3% and 7Yz inches
per second - although there was a high-
speed (7'2/15 ips) version available for ‘ultra-
fidelity’ and professional applications. In
terms of the head block, there were half-
track (two tracks) and quarter-track (four-
track) options. The quarter-track gave twice
the potential recording time from a single
spool of tape as the half-track, but at the
expense of a slightly worse signal-to-noise
ratio and greater risk of drop-out.
Domestic users tended to go for the
quarter-track, while professionals opted for
the security of half-track recording. There
were separate heads optimised for record
and playback. Apart from the performance
advantage, it was possible to compare the
recording with the original source. The
three-head configuration also opened up
creative possibilities, such as overdubbing
and echos. You could buy a A77 with Dolby
B noise reduction - it was one of the first
tape machines anywhere to have the facility
- if frequent slow-speed recording was
envisaged. Another interesting option was
the built-in 10W power amplifiers, which
were available as plug-in modules. Some
models even had the speakers built-in,
making the machine a true tape recorder
(rather than just a tape deck)! The power
supply specified for the A77 obviously had
to cater for those power amplifiers, even if
they weren't fitted. One of the heaviest
items in the machine is the massive mains
transformer, which feeds the various power
supply stages - most of which are stabilised.

Photo 2. The top of the A77 sans case, showing the two Papst reel motors.
The massive mains transformer can be seen near the centre of the image.
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Photo 3. An overall view of the A77's rear, showing the neat construction and easily-

accessible components - a joy to service!

The deck’s reliability made it very popular
in recording studios, radio stations and
high-end audio installations. Pretty much
every famous musician of the day had an
A77 to ‘jam’ with! There’s a verv good
chance that the A77 you acquire for a few
pounds art a junkshop will deliver most of
its functionality. The hardware was built like
the proverbial tank, with a massive die-cast
aluminium chassis that formed the basis of
the deck. Designer Willi Studer avoided
perishable belts and idlers wherever
possible, and this did a lot for their
reliability. Indeed the only drive belt in the
A77 couples the take-up spool carrier to the
tape counter. All transport functions was
invoked with relays and solenoids, making
possible the aforementioned remote control
(if you wanted to, vou could control it from
a computer if you were to design and build
an appropriate interface). Very unusually for
the day, the A77 featured electronic servo-
regulated speed control of the
asynchronous capstan motor.

Iinternals

The capstan was directly-driven by the
motor, a very heavy outer rotor acting as a
‘flywheel’ to iron out any servo ‘hunting’ that
could cause audible pitch variation. A series
of 120 teeth on the flywheel induces a tone
(800Hz at 3*/ips, and 1.6kHz at 7Yzips) in an
adjacent tape-head like pick-up sensor, and
this is used for feedback. At 3%4ips, the
capstan rotates at 400 rpm (twice that for
the higher speed). Theoretically, vou could
modify the machine to work at other speeds
simply by changing components, but the
equalisation circuits may also nced to be
modified to deliver the correct plavback
characteristic. As with many audiophile
recorders, the reel motors directly-drive the
spool carriers. In fast mode (rewind or fast
forward), full voltage (105V AC) is applied to
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the relevant reel motor. The other motor.
which works in the opposite direction, is
energised with a much lower voltage (21V)
to prevent ‘looping’ and keep the tape
sufficiently taut - important if vou suddenly
hit stop in the middle of a rewind operation!

In playback mode, 35V (102" reel) or 42V
(7" reel or smaller) is applied to the take-up
motor, giving just enough torque to catch
the tape as it’s spat out by the capstan and
pinch roller. The feed spool motor is also
energised (49V for the larger reel size, 36V
for smaller reels). The result is a fair amount
of back-tension, which ensures that head-to-
tape contact is intimate. The other way of
achieving this, found in competing tape
recorders of the day, was to employ pressure
pads. In plavback mode, sprung arms
mounted with these small pieces of felt
forced the tape against the head.
Unfortunately, pressure pads required
regular cleaning or they would clog with
oxide. In the worst case, they would become
hard and accelerate head wear. The A77's
superior solution, which was later widely
adopted by other recorder manufacturers, is
responsible {or a long head life.

Indeed, the heads of even some of the
earliest examples are in a passable state -
provided they were maintained regularly
and used with good-quality tape. Some of
the ex-studio machines have been thrashed
though, and are hence in a rather poor
state. It’s worth examining the head block

for extensive wear, and - if possible -
powering up the machine and checking out
the functions with a test tape if you have a
chance. Replacement record and playback
heads for the A77 (and its eventual
replacement, the B77) sell for a ludicrous
&144 each, and that's before VAT at 177:% is
added! If the heads are badly worn, your
purchase may not be the hargain you
originally thought. Converting between 2-
track and 4-track is expensive - three new
heads are required, as are changes to the
bias oscillator! Make sure that any machine
you plan to buy conforms to the track
configuration of your old recordings!

‘Official’ Revox spares are, in this writer’s
opinion, somewhat overpriced. A VU meter
movement (of the type that Maplin might
sell for £5) has a £33.45 (+VAT) price tag
once it’s got that Revox tag slapped on!
Expect to pay nearly £20, meanwhile, if you
need to replace one of the ‘record select’
toggle switches on vour B77. In other
words, do your bank account a favour and
use third-party components whenever it is
safe or practical to do so! Sometimes, a bit
of ingenuity helps. One A77 that came my
way had a snapped brake band - basically a
steel stip that is wrapped around the spool
carrier, via the action of a solenoid,
whenever the deck is in 'stop” mode.
Fortunately, the break was near the pivot,
and a repair was effected by cutting a nick
on either side of the strip’s end. A piece of
copper wire was then looped around the
band, and passed through a rivet hole on
the pivot. The ‘bodge’ was then reinforced
bv applying solder.

Obtaining a Manual

You might find, however, that one expensive
‘official’ item is available free of charge. The
A77 service manual might be kept at your
local library. Many of the bigger facilities
(such as Chelmsford in Essex) have a
bewilderingly-comprehensive selection of
manuals. We were able to get the A77
manual from Chelmsford on this basis. If vou
can’t find what vou’re looking for locally,
most public libraries run an ‘interloan’
scheme. The librarian should be able to find
out whether the manual of interest can be
obtained. They might even purchase the
pubtication if it’s not in stock anywhere in
the county! The well-written A77 manual is
an excellent example of the art, with
exploded views (including the motors!),
circuit diagrams/descriptions, calibration
details, parts lists and modification details. Tt
also caters for the Dolby version of the
machine, and details the power amp
modules and remote control.

Phioto 4. A closé-up view of the répared hfake band, hefore it was refitted to the deck.
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Electronics

Low-noise silicon transistors (BC108 et al)
were specified in the A77's small-signal
circuitry. Generally, the Revox electronics is
exceptionally reliable. If something does go
wrong, its worth knowing that all of the
machine’s audio circuits (record/replav
amps, bias oscillator, ctc.) take the form of
plug-in modules for ease of service. When
you obtain a machine that’s more than 25
vears old, it is worth replacing the
electrolytic capacitors - particularly those in
the power supply section. Over time, they
can become rather leaky and the result is
an audible hum. Some of the small-value
clectrolytics in the signal electronics have
some non-standard values - 125mF, for
example. Still, a 100uF and 22uF in parallel
comes close... Other components can be
replaced by ‘off the shelf " Maplin items.
The ampilifiers and bias oscillator are of
conventional design, and hence quite easy
to troubleshoot in the event of a fault.

The end-tape sensor takes the form of a
light-dependent resistor (LDR) on the head
block, which works in conjunction with a
filament bulb. The resistor, which falls in
value when light is present (i.e. when no
tape is obstructing the light path), is
connected to a Schmitt-trigger type circuit
that triggers a ‘stop’ relay. Sometimes, the
photoresistor will fail and the mechanism will
continue to operate when the tape has
finished. It will thus need to be replaced -
with more modern components. A
phototransistor could be specified, but the
associated circuitry would require
modification, If the end-tape sensor doesn’t
work, it stands to reason that you should
check the lamp too! The A77 pre-dates LEDs
by many vears - filament bulbs also tell you
which of the channels are selected, as well as
back-illuminating the VU meters. They might
need replacing... Note, by the way, that the
A77's VU meters only monitor the input.

If the deck refuses to operate, you might
find that the blanking plug for the ‘remote
control” socket - located amongst the
plethora of audio socketry - has been
removed. Maplin don’t, sadly, sell the 10-

Photo 5.

A close-up view
of the A77's all-
important record
record and play
heads. These are
quarter-track types
that permitted
stereo recordings
to be made on
both sides of the
tape. Those who
wanted the best
performance would
have opted for
haif-track heads,
and ‘one side-only’
recording.
Half-track opened
up creative
possibilities,
though - feed the
tape in the ‘wrong’
way and you get
‘backwards’
playback...

pin DIN plug. If you can obtain one of
these, short out pins 1 and 2 and insert
into the remote control socket. If you're
unlikely to need remote control (vou could
build vour own from the circuit diagram
given in the service manual), then the
relevant pins on the socket could be linked
with wire. On which subject, the A77 has a
safety interlock that stops vou from
operating the machine without its case. A
mains shorting plug, which is attached to
the rear of the case, makes contact with a
shrouded socket fitted on the chassis.

To make vour life easier during servicing,
vou could bypass this interlock. While on
the subject of mains, the A77 (and other
more recent Revox audio products, come
to think of it) has a non-standard 2-pin
mains connector. It’s a bit like an IEC mains
connector, but doesn’t have an earth pin.
What’s more, the pitch between the live
and neutral pins are different to that of an
IEC lead, so you can’t improvise! If vou
don’t have the original mains lead, you
could replace the Revox mains socket with
a standard IEC one. It fits quite nicely into
the same space. Note, however, that the

: Photo 6.
: The A77 remote
: control socket.
: Pins 1 and 2
: must be shorted
in the absence

: of a remote
: control. Normally,
¢ this would be
achieved by
means of a
‘blanking’ plug.

original socket is rivetted, rather than
bolted, in!

Sometimes, the level controls will
‘crackle’ when adjusted thanks to
oxidisation of the intcrnal contacts. The
cure is to apply switch cleaner (e.g.,
Maplin’s JP17T) into the relevant variable
resistors - there’s normally a convenient
aperture into which the substance can be
squirted. An extension nozzle supplied with
the cleaner helps vou direct it to where it’s
needed. After it's been applied, turn the
control back and forth a few times to
ensure that the stuff gets evenly spread
around! Other elements of the deck will
benefit from a clean - often, there’s a lot of
dust inside these machines. The head
block, heads, capstan, pinch roller and tape
guides should all be cleaned with isopropyl
alcohol. 1t’s also worth demagnetising the
record and play heads. Maplin used to sell
the perfect device for the job - this focused
a strong mains field into a rubber-coated
prong that could be brought into contact
with the head. Unfortunately, the device is
no longer available, at least from Maplin.

Not much restoration work is required to
bring the average A77 back into good
working order - and that’s a practical
testimony to the excellence of its design.
But then again, it was a very expensive
machine (when production of its B77
successor stopped last year, the asking
price was two and a half thousand
pounds!). The sound qualitv available from
these decks is truly excellent, provided that
the recordings were good to start with. I
have myself transferred a good few
recordings onto CD with an A77 or B77 as a
source deck. Maintain it periodically, and a
Revox tape deck is probably good for
another thirty years. The same cannot be
said of most other audio equipment!

Revox spares
can be obtained from:

Revox Spares, TTL House,
Sheep Tick, Lidlington, BEDS, MK43 O5F;
Tel: (01525) 841999
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QuickTime 4

Last month we reported on the beta version of QuickTime 4
that Apple had posted on its Website. Since then the final
version has been released, and it is now available as a free
download from: <http://www.apple.com/quicktime>, in both
Windows and Macintosh versions. Featuring streaming audio
and video clips, QuickTime
represents something of the
future of multimedia on the - -
Internet, so it's worth ’,,‘E.i,‘,y
downloading for the sheer A
fun of it. Since its original
beta posting just a couple of
months ago, there have
already been over six million
downloads of the software.
QuickTime 4 has a rather
neat installation routine, in
that to start with, you only
need to download the
installer itself, which is a
comparatively smalil
download (380k in Mac
format). Once you run it
however, the installer logs
you onto the QuickTime site
automatically, and allows you to choose what parts of the
software you want to he downloaded and installed. A total

braking
ahifting
elimbing

dencending

install is quite a size, but by selecting carefully what you think

you'll be likely to need, you can keep online times to a
minimum. In a rather clever way after installation, QuickTime
will tell you if you're trying to use a QuickTime muitimedia file
that requires part of the software you haven’t yet installed
and asks you if you want to download and install it to suit.

Once you've downloaded and installed QuickTime 4,
checkout the links from the Apple Website to various media
organisations around the world (including the BBC). Mountain
bikers might like to try the SingleTrack site at:
<http://www.singletrackonline.com> to see some streaming
QuickTime clips of mountain biking videos.

Mapping a Pyramid

Occasionally you hear a news item about the Internet that
raises a smile. Here’s one that many schools around the
world might appreciate. One school - the Mill Cove District
School, in Nova Scotia - thought of a great idea to generate
some interest in geography with one class of its pupils. The
15 children in the class sent an email to 15 relatives each.
Each email message asked the recipient to reply with details
of their location, then forward the email message to as
many people as possible with the same request to reply with
location details and forward on. As the email responses
were received, the class were to mark the locations on a
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world map to see where in the world the email messages
they sent actually travelled.

By the end of the first day after sending the initial email
messages, the class received over 180 responses. On the
following day 250 more rolled in, and by the end of the first
week some 200 messages an hour were being received. Then
the school’s email server groaned and collapsed under the
strain, and the project was
suspended. In an attempt to
stem the flow, the school
cancelled its email address,
so the email respondents
started to send faxes, letters,
and even phoned the school.
Last we heard, the school was
still suffering from an overload
of information.

TECHNIQUE OE

Cable Modems

If you're a cable telephone or
- television user and dying to get
thinking about cable modems.
Currently, these are being rolled
out across the country in more
and more cable telephone
areas operated by NTL, and the whole country should be
covered by the end of the year.

Cable modems effectively allow maximum data burst
transfer rates of some 3Mbps, and should allow average
maximum rates of around 500Kbps. Now that is around ten
times the maximum rate even a modern modem and
computer combination can reach over standard telephone
lines, and it's even four times the maximum rates ISDN can
deliver! In other words, cable modem access over a cable
service is simply unbeatable by any other landline form of
Internet communications. While the street price of cable
modem service (called HiSpeed Internet, by NTL) isn’t cheap
at around £40 a month, it is a fixed fee regardless of how
long you stay connected to the Internet, so should be a
viable proposition for anyone who uses the Internet a lot and
will mean that there are no surprise hidden charges when
the phone bill arrives on the doorstep.

While other cable modems will be available soon, currently
NTL uses only one particular cable modem. It's manufactured
by 3Com, and is the USRobotics CMX cable modem. Details
of the cable modem can be found at the 3Com Website, at:
<http://www.3com, com/products/cablemodem/index.html>. To
connect to the cable modem, a computer needs an Ethernet
port, so most PCs will need a network interface card fitted,
while Macs will plug straight into it. NTL plans to sell the
cable modem to cable subscribers, on its own or as a
package with a network interface card.
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PC Nanny available for download at <www.netnannv.com> is designed for
people, who are looking for ways to protect personal, and in some cases,
work-related, computer files and functionality on their home computers.

PC Nannv allows users to hide or block access to the following: display and
hardware settings, disk, zip and CD-ROM drives, MS DOS, the ‘Device
Manager’ page, the "Start’ menu, the ‘Find’ key and individual computer files.
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Amazon ~ Books and Music

<www.amazon.co.uk>

Amazon is the UK subsidiary
of Amazon.com, the online
retailer of books and music. At
Amazon.co.uk you'll find
more than 1.5 million locally
published titles, easy-to-use
search and browse features,
customised e-mail notification,
personalised shopping
services, secure Web-based
credit or debit card payment
and direct delivery.

If you know what you want,
g0 straight to the Amazon
search engine where you'll be

BlackStar

able to find your book in
seconds and check reviews
from other users. Ordering at
Amazon.co.uk is fast and
secure. After you've made
your first purchase, your
Amazon.co.uk account is
automatically creared. You can
then use single click ordering
10 buy almost instantaneously.

Amazon charges for the
cost of the book, which is
typically discounted by up to
50% from the high street
price and postage.

Videos and digital video disks (DVDs)

<www.blackstar.co.uk>

- -

(37 Location: [t/ 7w blackstar.co uk/

with ‘ree postage worldwide

R /ogin / register

Black Star is a UK success story.
The UK's biggest video store,
Black Star brings an innovative,
highly customer-driven
approach to the emerging
market for goods bought on-
line. Two factors - customer
obsession and continuous
innovation - lie behind its
drive to become a pioneering
global force in e-business.

Based in Belfast, the
company sells more than
50,000 videotape and DVD
titles, including every release
currently available in the UK,
compared with an average of
around 2,500 titles in a
traditional High Street outlet.
Black Star is on 2 high growth
curve: having been launched
early in 1998 they have
consistently achieved an
average sales growth of 40%
month on month.

An extremely high level of
customer focus sets Black Star
apart from other Web-based
businesses selling consumer
goods. Customers are given
unparalleled personal attention

——T L — = m sam cmm s

ACK STAR

the UK's biggest video store
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that includes dialogue about
their purchases, updates on
relevant new releases and
products, and a unique Video
Hunt Service for tracking
down rare and deleted video
titles, Customers can also
search and browse catalogues
online according to a film’s
director, stars, title, distribution
company, year or category.

All items are delivered free
within 24 to 48 hours in the
UK, and monthly promotions
on hundreds of titles, Black
Star provides a compelling
alternative to High Street
video shopping. Purchases
are made online using a
secure ordering and transaction
processing system that
accepts all major credit cards,
cheques and money orders.

Once despatched all orders
are tracked automatically
until they reach their final
destination — the customer’s
letterbox. Videos and DVDs
are typically discounted and
postage is free.
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Argos ~ Catalogue shopping
<www.argos.co.uk>

-
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Browse from the selected range of
products in our Online Shop, or if you
know what you're looking for simply
use the Search.

Alternatively, use the navigation

Welcome to the Argos
Internet Site

The Argos Web site is a lot like the familiar catalogue. It contains
thousands of products to choose from, ranging from DIY and
bedroom furniture, to jewellery and gifts.

The site is clear and user friendly with a powerful search engine.
Browse through the Internet Shop, adding products to your
Shopping Bag. You can view or change the contents at any stage.

If you already know what you want from the catalogue, then
you can simply enter the paper version of the catalogue number
on the order form next to a product.

You can pay by any Visa or Mastercard eredit card, Switch or
Delta debit card or by using Argos Personal Account card. Your
order details will be encrypted to ensure secure transfer of data.
There is a £5.00 delivery charge per order, no matter how many

items you order.

Parcelforce is used to deliver most goods within 4 to 6
working days from when you place an order. Some larger items,
covered by the Argos free home delivery service take up to 14
days, as specified in the product text.

o e

Lastminute ~

Holidays and travel arrangement
<www.lastminute.com>

This site allows you to make
bookings at the last minute
for everything including
flights, hotel rooms and
entertainment tickets at
discounted prices. It’s a great
site with plenty of bargains to
choose from.

The site tends to have offers
for the next two to three weeks.
Offers change daily so it is
worth checking the site
regularly for the latest availability,

Everything you see on the
site is available to buy
immediately. It is simple and
completely secure. You can
use Visa or Mastercard to
make your booking. All the
prices you see on the site are
the real prices — all taxes and
VAT is displayed clearly by
the product.

When you have ordered
from lastminute.com you will
receive instant e-mail
confirmation of your order.

Airline tickets are either

delivered by overnight
guaranteed delivery for which
you will need to sign and pay
£3.20, or if you have chosen
the ticket on departure
option which costs £15, they
are issued 4t the airport.
Entertainment tickets are
collected at the Box Office of
the theatre — the theatre will
debit your card and the tickets
will be available at the Box
Office upon presentation of
your card. Hotel bookings
have nothing to collect but the
hotel will ask for your credit
card and will debit that card
when you arrive at the hotel.
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Screentrade
Competitive insurance quotes
<www.screentrade.co.uk>

Instant insurance
from the names you know

g i trade

waw.screentradecouk

About us
Our promise

LI - Compare prices and policies
+ Reduce premiums on the spot
« Then buy on-line or by phone

hen you
buy otiling
Quick tour

About the insurers Click below to get quote i |20

Useful links

Jobs @ @

Screentrade offers a quick and convenient way of comparing the
different insurance policies on offer, displaving the best quotes
available from most major UK insurers. with all the kev
information contained on a single page. Users can compare
prices and features, and then go on to buy on line the one that
really suits them best, all in about the same time as it takes to
call one direct provider.

The site will automatically prepare a number of competitive,
personalised quotes for vou in just a few minutes. Then you can
compare prices and cover, and see just what you're getting for
your money - you'll probably be surprised how policy features
differ. All you do is key in your details once, and you're in touch
with some of the biggest names in the market. And then vou
can buy online, or over the phone, whichever suits you best.

Users have access to eight products from six of the main home
insurance providers: Independent, Zurich, Eagle Star, Commercial
Union, Folgate and AXA. The motor insurance service offers a
range of 16 products from a panel of seven insurers; Norwich
Union, Royal & Sun Alliance, Zurich, Bishopsgate, Folgate, GAN,
and ITT London & Edinburgh. Travel is currently available from
two providers, Bishopsgate and Norman.

Maplin Electronics

Electronics products and components
<www.maplin.co.uk>

Not wishing to sound too congratulatory, we're featuring our own
Web site as a premier online shopping location. After a great deal of
behind the scenes work on Maplin's IT systems, the company
recently announced an online catalogue system.

The new svstem is an extension ol its paper based and CD-ROM
catalogue. The site is hosted on a secure server and offers order
authorisation, which is flexible and reliable with personalised reference
numbers. The reference number svstem treats customers as individuals
and fadilitates product tracing by sending an update e-mail immediately.

The unique attributes to the site, come as a direct result of
customer feedback, Maplin talked to its customers and prioritised
their key requirements. Thus an online browseable catalogue,
comprehensive search option, coupled with technical data and
product information the customer has grown to expect.

All of these features had to be built into the system, whilst
providing stock availability and secure ordering. Key features of this
e-commerce site are that Maplin customers actually create their
own orders while
online. This
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Internet visit.

Since early this century
Interflora has delivered flowers
worldwide. No one can
compete with the company’s
combination of creativity,
experience and guaranteed
qualitv. The organisation
consists of 38,000 florists
located far and wide from
China to Russia delivering
flowers to 146 countries.

Visitors to the Interflora
Web site are given a selection
of arrangement tvpes ranging
from new birth to hirthday
and wedding anniversary to
sympathy. Once vou select 4
category the Web site offers a
selection of arrangements
ranging in price from around
&10 1o &30.

At this point vou’'ll need
willpower. The site offers a

ShopGuide

Interflora ~ Flowers
<www.interflora.co.uk>

selection of additional gifts
including chocolates, a teddy
bear and a balloon to
accompany vour order. Finally
vou need to enter credit card
details, message details and
the name and address of the
person to whom vou're
sending the gift.

Once the order is complete
a unique customer reference
numbher is generated. This
enables the order to be
tracked, not unfortunately via
the Web, but by telephone.

Interflora cerrainly is not the
cheapest way of buying flowers,
but it is convenient. If you've
forgotten a bircthday they can
despatch a delivery within 24
hours. Expect to pav a £2.99
handling charge in addition to
the cost of your flowers.

Online shopping portal
<www.shopguide.co.uk>

2] Locations [hts /7w shopgue co uk/

ShopGuide Home | Shopping Directory | Batgain Finder (Bestseller Charts

About ShopGuide |Help
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Welcome to ShopGuide - online shopping made easy!

Friday 2nd July 1999

Directory Quick Links  ShopGuide 1s your Impantial Consumer Guide 1o online shopping Not only
do we review and rate over 400 secure UK shops in our comprehensive

Books and Magazines

Clothes and Fashion
mputer Hardware

Comgputer Software 0O Geir

Shopping Directory, but we also help search the best UK shaps through
our new sophisticated comparison shopping agent called Bargawn Finder.

e - To The Person With The Mouse!

Department Stores

Electronics

WIN a pair of tickets to New York from Lastrninute.com!

Flowers and Cards

Don't vou hate it when you a buy a CD, book, game or video
and then sce it cheaper somewhere clse? Wouldn't yvou love it if
vou could find all the best prices for the latest releases without

even leaving your home?

With the faunch of its new Web site in April, ShopGuide
enabled consumers to compare online prices from a variety of
Web sites using an online tool called BargainFinder.

Until now this service has onlv been available in the US but
ShopGuide's BargainFinder brings this technology to the UK
shopper for the first time. Already top retail names such as Amazon,
W11Smith and Entertainment Express have signed up to the service
that is already delivering the best deals available on the Internet.

Best seller charts for all the hottest CDs, videos, games
and books are another much welcomed addition to the site. All
of the titles on the charts are linked into BargainFinder - just
click on the item you are interested in buying and up comes a
list of all the UK stockists inclucling prices - enabling you to
select the best deal out of the top UK retailers.

But ShopGuide is not just about buying books and videos
either; the shopping portal lists hundreds of recommended UK
Web sites selling thousands of different items. So, whether you
are buying a bunch of flowers for your mum, a holiday to the
Caribbean or a bottle of vintage champagne - ShopGuide's
impartial guicdle means that vou can buy from the Internet

quickly and conveniently.
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FTSE 100 Web Sites Are

Almost half of the UK’s leading quoted
businesses are using the Web as little more
than online wallpaper and are failing to
capitalise on its potential as a direct
communication medium with customers,
investors and other target audiences.
Some are even in the precarious position
of failing to deliver on promises they make
on their sites to customers and investors.

This is the conclusion of a study into the
use of the Web by FTSE 100 companies,
conducted between 30 March and 12 June
1999 by marketing communications
consultancy Rainier Limited.

The study found that 26 of FTSE 100
companies - including BAA, CGU, NatWest
and 'lesco -failed to respond to a request
for basic investor information after a wait
of more than 75 days.

A further 16 companies, including BASS,
ICI, and Vodafone either did not have a
Web site, could not be contacted by e-mail,
or e-mail contact details were not easily
located on their Web site.

‘Having a Web site without a direct

"Corporate Wallpaper'

feedback mechanism is like having a
freephone help line, but no receptionist.
Corporate UK is completely failing to
recognise the capability the Web and some
of those that have invested in it are
leaving themselves dangerously exposed
to frustrating their customers, partners
and investors,’ said Steve Earl, director,
Rainier Limited.

Of the 58% of FTSE 100 companies that
responded to an investor query from their
Web site, 23 took less than three hours, 21
took between three hours and one day, 10
took between a day and threc davs and a
further 4 took more than three days.

The UK’s most responsive companics
include Billiton (one min), Allied Zurich
(three mins), Smiths Industries (three
mins) and Zeneca (eight mins). Amongst
the UK's least responsive companies are
Severn Trent (six days 20hrs 52 mins),
Ladbroke (nine clays 44mins), Standard
Chartered (20 days) and Boots (30days
21hrs 43mins).

‘Under three hours is an acceptable

Q Location: ]http://www.mwmesweeper,com/
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Service In Europe

Dell Launches Free Internet

PC maker Dell at <www.de11.com> has rolled out its free DellNet
Internet service in the UK at <del1net.excite.co.uk> and
plans to expand to Germanv and France. The company savs it
will extend the service to other European countries later this
vear. Software for the service will come pre-installed on Dell's
consumer and small-business computers, and is available for

Internet Users Deluged by Junk E-Mail

timeframe in which to respond to a Web
inquiry, vet less than 25% of FTSE 100
companies met this criterion. Corporate
companies are failing to recognisc that the
Web provides a valuable opportunity for
direct communication with customers,
investors and partner and should have the
back office infrastructure in place to cope
with integrating their Web presence with
traditional investor and customer
communication systems such as telesales
and helplines,” said Earl.

The survev found that six of the UK’s
FTSE 100 companies, including GUS, lLand
Securities and Prudential, provided no
contact information such as address,
telephone or fax details of any kind on
their Web site, while nine of the FTSE
companies provide an address and phone
number only.

99 of the 100 FTSE companies have a
Web site of varving degrees of sophistication.
The study found that British American
‘Tobacco was the only FTSE 100 company
without an online presence.

Misuse Impact Business

Content Technologies, the developer of the MIMEsweeper product family at
<www.mimesweeper. com>, has published a White Paper entitled 'Business Issucs
Relating to Content Security and Policy Management',

The paper meets a growing demand among Internet users for information on
the financial, cultural and legal risks to a company as a result of accidental and
deliberate misuse of the Web and e-mail in Europe.

The third in a series of Content Technologies papers, the document discusses
how Internet usage, including internal and external ¢-mail, can cause breaches of
confidentiality and exposure to legal liability. It outlines the similaritics and
differences between liability and privacy laws in eight European countries.

To obtain a copy of the White Paper, please contact Anna Sutherland at Content
Technologies on tel: (0118) 930 1300, or e-mail anna. sutherland@mimesweeper. com.
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making schemes, adult ads, and software offers were the most
frequently received bulk e-mail.
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